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Preface

Safety information

Note: For general safety information, see this Preface and Appendix B, “Safety” on
page 119. When a hazard symbol and hazard type appear by an instrument hazard,
see the “Safety” Appendix for the complete alert. For all chemicals, read the MSDS
and follow the handling instructions. Wear appropriate protective eyewear, clothing,
and gloves.

Safety alert Four safety alert words appear in Applied Biosystems user documentation at points
words in the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular
level of observation or action, as defined below:

IMPORTANT! — Indicates information that is necessary for proper instrument
operation, accurate chemistry kit use, or safe use of a chemical.

C CAUTION! - Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

é DANGER! - Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury. This signal word is to be limited to the
most extreme situations.

MSDSs The MSDSs for any chemicals supplied by Applied Biosystems or Ambion are
available to you free 24 hours a day. For instructions on obtaining MSDSs, see
“Obtaining MSDSs” on page 121.

IMPORTANT! For the MSDSs of chemicals not distributed by Applied Biosystems
or Ambion contact the chemical manufacturer.
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Overview

This chapter covers:
B Product OVeIrVIEW . . . ..ttt
B OWOrKfIow OVEIVIEW . . . . oottt e e e e
B Instrument and software overview. . . .......... .. .. .. .

B Materials and equipment . . ... ...t e
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Chapter 1 Overview

Product overview

Purpose

Product
description

About the primers

The AmpF(STR® NGM™ PCR Amplification Kit is a short tandem repeat (STR)
multiplex assay that amplifies 14 tetranucleotide repeat loci and one trinucleotide
repeat locus, D22S1045. The kit simultaneously coamplifies the 10 loci contained in
the AmpF(STR® SGM Plus® kit (D3S1358, vWA, D16S539, D2S1338, D8S1179,
D21S11,D18S51,D19S433, THO1, and FGA) together with two highly polymorphic
STR loci (D1S1656 and D12S391), 3 “mini” STR loci (D10S1248, D22S1045 and
D2S441), and the gender determination locus Amelogenin. The AmpF(STR® NGM™
Kit delivers a 16-locus multiplex with a greater power of discrimination, better
sensitivity, and improved robustness than earlier generation kits. The kit uses
modified PCR cycling conditions for enhanced sensitivity, a new buffer formulation
to improve performance with inhibited samples, more loci concentrated in the low
molecular-weight region of the profile to improve performance on degraded samples,
and an improved process for synthesis and purification of the amplification primers
to deliver a much cleaner electrophoretic background.

The AmpF(STR® NGM™ Kit contains all the necessary reagents for the
amplification of human genomic DNA.

The reagents are designed for use with the following Applied Biosystems
instruments:

+ ABI PrISM® 3100/3100-Avant Genetic Analyzer

* Applied Biosystems 3130/3130x/ Genetic Analyzer

* Applied Biosystems 310 Genetic Analyzer

+  GeneAmp® PCR System 9700 with the Silver 96-Well Block

+  GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

The AmpF(STR® NGM™ Kit employs the latest improvements in primer synthesis
and purification techniques to minimize the presence of dye-labeled artifacts. These
improvements result in a much cleaner electropherogram background that enhances
the assay's signal-to-noise ratio and simplifies the interpretation of results.

AmpFSTR® NGM™ PCR Amplification Kit User’s Guide



Product overview

Loci amplified by

the kit

The following table shows the loci amplified, their chromosomal locations, and the
corresponding fluorescent marker dyes. The AmpF(STR® NGM™ Allelic Ladder is
used to genotype the analyzed samples. The alleles contained in the allelic ladder and
the genotype of the AmpF{STR® NGM™ Control DNA 007 are also listed in the

table.
Table 1 AmpF(STR® NGM™ Kit loci and alleles
Locus desianation Chromosome Alleles included in AmpF(STR® NGM™ Dye Control DNA
9 location Kit Allelic Ladder label 007

D10S1248 10026.3 8,9, 10, 11,12, 13, 14, 15, 16, 17, 18 6-FAM™ 12,15

VWA 12p13.31 11,12,13, 14,15, 16,17, 18,19, 20, 21,22, | 6-FAM™ 14,16
23,24

D16S539 16924.1 5,8,9,10,11,12,13, 14, 15 6-FAM™ 9,10

D2S1338 2935 15,16, 17,18, 19, 20, 21, 22, 23, 24, 25, 6-FAM™ 20, 23
26, 27, 28

Amelogenin X: p22.1-22.3 X, Y VIC® X, Y

Y: p11.2

D8S1179 8024.13 8,910, 11,12,13, 14, 15,16, 17, 18, 19 VIC® 12,13

D21S11 21911.2-g21 24,24.2, 25, 26, 27, 28, 28.2, 29, 29.2, 30, VIC® 28, 31
30.2, 31, 31.2, 32, 32.2, 33, 33.2, 34, 34.2,
35, 35.2, 36, 37, 38

D18S51 18021.33 7,9,10,10.2,11,12,13,13.2, 14,14.2,15, | VIC® 12,15
16,17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27

D22S1045 22912.3 8,910, 11,12, 13, 14, 15, 16, 17, 18, 19 NED™ 11,16

D19S433 19g12 9,10, 11,12,12.2,13, 13.2, 14, 14.2, 15, NED™ 14,15
15.2,16,16.2,17,17.2

THO1 11p15.5 4,5,6,7,8,9,9.3,10, 11, 13.3 NED™ 7,9.3

FGA 4928 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 26.2, NED™ 24,26
27,28, 29, 30, 30.2, 31.2, 32.2, 33.2, 42.2,
43.2,44.2,45.2,46.2,47.2,48.2,50.2, 51.2

D2S441 2p14 9,10, 11, 11.3, 12, 13, 14, 15, 16 PET® 14,15

D3S1358 3p21.31 12,13, 14, 15,16, 17, 18, 19 PET® 15,16

D1S1656 1942.2 9,10, 11, 12,13, 14, 14.3, 15, 15.3, 16, PET® 13,16
16.3,17,17.3, 18.3, 19.3, 20.3

D12S391 12p13.2 14,15,16,17, 18, 19, 19.3, 20, 21, 22, 23, PET® 18,19
24, 25, 26, 27
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Chapter 1 Overview

Allelic ladder Figure 1 shows the allelic ladder for the AmpF(STR® NGM™ Kit. See “Allelic
profile ladder requirements” on page 28 for information on ensuring accurate genotyping.
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Figure 1 GeneMapper® ID-X Software plot of the AmpF(STR® NGM™ Kit Allelic
Ladder
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Product overview

Control DNA 007  Figure 2 shows amplification of Control DNA 007 using the AmpF{(STR® NGM™
profile Kit.
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Figure 2 1 ng of Control DNA 007 amplified with the AmpF/(STR® NGM"" Kit and
analyzed on the Applied Biosystems 3130x/ Genetic Analyzer
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Chapter 1 Overview

Workflow overview

Extract DNA

L

PrepFiler™ Forensic DNA Extraction Kit

A 2

Quantify DNA

T e—

Quantifiler® Duo DNA Quantification Kit

s 4

Perform PCR
AmpF(STR® NGM™ PCR Amplification Kit

GeneAmp® PCR System 9700 Thermal Cycler*

* Amplification should be performed on silver- or gold-plated silver
96-well blocks only.

Perform Electrophoresis

e B

ABI PRISM® Applied Biosystems
ABI PRISM® 310 3100/3100-Avant 3130/3130x/ Genetic
Genetic Analyzer Genetic Analyzer Analyzer

4

Analyze Data

GeneMapper® ID or GeneMapper® ID-X Software
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Instrument and software overview

Instrument and software overview

Data Collection
and
GeneMapper® ID
or ID-X Software

Instrument and
software
compatibility

About
multicomponent
analysis

This section provides information about the Data Collection Software versions
required to run the AmpF(STR® NGM™ PCR Amplification Kit on specific

instruments.

The Data Collection Software provides instructions to firmware running on the
instrument and displays instrument status and raw data in real time. As the
instrument measures sample fluorescence with its detection system, the Data
Collection Software collects the data and stores it. The Data Collection Software
stores information about each sample in a sample file (.fsa), which is then analyzed
by the GeneMapper® ID or ID-X Software.

Table 2 Software specific to each instrument

Operating Data Collection .
Instrument system Software Analysis software
3130/3130x/* Windows® XP 3.0 ¢ GeneMapper® ID
Software v3.2.1
3100/3100- Windows NT® 1.1 (3100) and
Avant
1.0 (31 OO—Avant) . GeneMapper® ID-X
- Software v1.0.1 or higher

Windows 2000 2.0
310 Windows XP 3.1

Windows NT and 3.0

Windows 2000

1 Applied Biosystems conducted validation studies for the AmpF(STR® NGM™ Kit using this

configuration.

Applied Biosystems fluorescent multi-color dye technology allows the analysis of
multiple loci, including loci that have alleles with overlapping size ranges. Alleles for
overlapping loci are distinguished by labeling locus-specific primers with different

colored dyes.

Multicomponent analysis is the process that separates the five different fluorescent
dye colors into distinct spectral components. The four dyes used in the AmpF{(STR®
NGM™ PCR Amplification Kit to label samples are 6-FAM™, VIC®, NED™, and
PET® dyes. The fifth dye, LIZ®, is used to label the GeneScan™ 500 LIZ® Size

Standard.
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Chapter 1 Overview

How
multicomponent
analysis works

Each of these fluorescent dyes emits its maximum fluorescence at a different
wavelength. During data collection on the Applied Biosystems and ABI PRISM®
instruments, the fluorescence signals are separated by diffraction grating according
to their wavelengths and projected onto a charge-coupled device (CCD) camera in a
predictably spaced pattern. The 6-FAM™ dye emits at the shortest wavelength and it
is displayed as blue, followed by the VIC® dye (green), NED™ dye (yellow), PET®
dye (red), and LIZ® dye (orange).

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes
(Figure 3). The goal of multicomponent analysis is to correct for spectral overlap.

Dyes
6-FAM VIC NED PET LIZ
100 | | | | |

s ]
B 80 -
e i
w 60 -
8 i
N 40 -
© 4
g 20 1 ¥
o 4
=z 0 —
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500 550 600 650 700

Wavelength (nm)

Figure 3 Emission spectra of the five dyes used in the AmpF/STR® NGM"" Kit
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Materials and equipment

Materials and equipment

Kit contents and
storage

The AmpF(STR® NGM™ PCR Amplification Kit contains materials sufficient to
perform 200 (PN 4415020) or 1000 (PN4415021) amplifications at 25-uL reaction
volumes.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the primer set from light when not in use. Amplified DNA, AmpF(STR®
NGM™ Allelic Ladder, and GeneScan™ 500 LIZ® Size Standard should also be
protected from light. Keep freeze-thaw cycles to a minimum.

Table 3 Kit Contents and Storage

Component Description 200X Volume 1000X Volume Storage
AmpF(STR® NGM Contains forward and reverse 1 tube, 1.0 mL 1 bottle, 5.0 mL -15to0 -25°C on
Primer Set primers to amplify human DNA receipt, 2to 8 °C

targets. after initial use

AmpF(STR® NGM
Master Mix

AmpF(STR® NGM

Contains enzyme, salts, dNTPs,
carrier protein, and 0.05%
sodium azide.

Contains amplified alleles.

2 tubes, 1.0 mL
each

1 tube, 50.0 pL

1 bottle, 10.0 mL

1 tube, 75.0 L

-15to0 -25°C on
receipt, 2to 8 °C
after initial use

-15to -5 °Con

Allelic Ladder See Table 1 on page 3 for a list r??;,?ti’nﬁi;? SS;C
of alleles included in the allelic
ladder.

AmpF(STR® Contains 0.10 ng/uL human 1 tube, 0.3 mL 1 tube, 0.3 mL 2to8°C

male 007 DNA in 0.02% sodium
azide and buffer?.

Control DNA 007

See Table 1 on page 3 for profile.

t The AmpF(STR® Control DNA 007 is included at a concentration appropriate to its intended use as an amplification control (to provide
confirmation of the capability of the kit reagents to generate a profile of expected genotype). The AmpF(STR® Control DNA 007 is not
designed to be used as a DNA quantitation control, and laboratories may expect to see variation from the labelled concentration when
quantitating aliquots of the AmpF(STR® Control DNA 007.

For the AmpF/(STR® NGM™ Kit, the panel of standards needed for PCR
amplification, PCR product sizing, and genotyping are:

Standards for
samples

* Control DNA 007 — A positive control for evaluating the efficiency of the
amplification step and STR genotyping using the AmpF(STR® NGM™ Allelic
Ladder.

+ GeneScan'" 500 LIZ® Size Standard — Standard used for obtaining sizing
results. It contains 16 single-stranded labeled fragments of: 35, 50, 75, 100, 139,
150, 160, 200, 250, 300, 340, 350, 400, 450, 490, and 500 nucleotides. This
standard, which has been evaluated as an internal lane size standard, yields
precise sizing results for AmpF(STR® NGM™ Kit PCR products. Order the
GeneScan 500 LIZ Size Standard (PN 4322682) separately.

+  AmpF{STR® NGM™ Allelic Ladder — Allelic ladder developed by
Applied Biosystems for accurate characterization of the alleles amplified by the
AmpF(STR® NGM™ Kit. The AmpF(STR® NGM™ Allelic Ladder contains
most of the alleles reported for the 15 autosomal loci. Refer to Table 1 on page 3
for a list of the alleles included in the AmpF(STR® NGM™ Allelic Ladder.

AmpFSTR® NGM™ PCR Amplification Kit User’s Guide 9



Chapter 1 Overview

Equipment and  Tables 4 and 5 list required and optional equipment and materials not supplied with
materials not the AmpF(STR® NGM™ Kit. Unless otherwise noted, many of the items are available

included from major laboratory suppliers (MLS).
Table 4 Equipment

Equipment

Source

ABI PrisM® 3100/3100-Avant Genetic Analyzer

Applied Biosystems 3130/3130x/ Genetic Analyzer

Applied Biosystems 310 Genetic Analyzer

Contact your local
Applied Biosystems
sales representative

GeneAmp® PCR System 9700 with the Silver 96-Well Block N8050001
GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block 4314878
Silver 96-Well Sample Block N8050251
Gold-plated Silver 96-Well Sample Block 4314443
Tabletop centrifuge with 96-Well Plate Adapters (optional) MLS

Table 5 User-supplied materials*

Item Source

AmpF(STR® NGM™ PCR Amplification Kit (200x/1000x) 4415020/4415021
3100/3100-Avant Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3100-Avant Genetic Analyzer Capillary Array, 36-cm 4333464
POP-4™ Polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-Well Reaction Plate N8010560
250-uL Glass Syringe (array-fill syringe) 4304470
5.0-mL Glass Syringe (polymer-reserve syringe) 628-3731

For a complete list of parts and accessories for the 3100 instrument, refer to Appendix B of the ABI Prism® 3100

Genetic Analyzer and 3100-Avant Genetic Analyzer User Reference Guide (PN 4335393).
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Materials and equipment

Table 5 User-supplied materials*

ltem Source
3130/3130x/ Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130x/ Genetic Analyzer Capillary Array, 36-cm 4315931
POP-4™ Polymer for 3130/3130x/ Genetic Analyzers 4352755
3130/3130x/ Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-Well Reaction Plate N8010560

For a complete list of parts and accessories for the 3130x/ instrument, refer to Appendix A of the Applied Biosystems
3130/3130x! Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (PN 4352716).

310 Analyzer materials

310 DNA Analyzer Capillary Array, 47-cm 402839
0.5 mL Sample Tray 5572
96-Well Tray Adaptor (for 9700 thermal cycler trays) 4305051
GeneScan™ 500 LIZ® Size Standard 4322682
Running Buffer, 10X 4335643
Genetic Analyzer Septa Retainer Clips for 96-Tube Sample Tray 402866
Genetic Analysis Sample Tubes (0.5-mL) 401957
Septa for 0.5-mL Sample Tubes 401956
DS-33 Matrix Standard Set (6-FAM™, VIC®, NED™, PET®, and LIZ® dyes) for 4318159

ABI PRISM® 310/377 systems

MicroAmp® 8-Tube Strip, 0.2-mL N8010580
MicroAmp® 96-Well Base (holds 0.2-mL reaction tubes) N8010531
MicroAmp® 96-Well Full Plate Cover N8010550
MicroAmp® 96-Well Tray/Retainer Set 403081
POP-4™ Polymer for the 310 Genetic Analyzer 402838

For a complete list of parts and accessories for the 310 instrument, refer to Appendix B of the ABI PRISM® 310 Genetic
Analyzer User Guide (PN 4317588).

AmpFSTR® NGM™ PCR Amplification Kit User’s Guide 11
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Table 5 User-supplied materials*

ltem Source
PCR Amplification
MicroAmp® 96-Well Tray N8010541
MicroAmp® Reaction Tube with Cap, 0.2-mL N8010540
MicroAmp® 8-Tube Strip, 0.2-mL N8010580
MicroAmp® 8-Cap Strip N8010535
MicroAmp® 96-Well Tray/Retainer Set 403081
MicroAmp® 96-Well Base N8010531
MicroAmp® Clear Adhesive Film 4306311
MicroAmp® Optical Adhesive Film 4311971
MicroAmp® Optical 96-Well Reaction Plate N8010560

Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Tris-HCL, pH 8.0 MLS
EDTA, 0.5 M MLS
Vortex MLS

1 For the Material Safety Data Sheet (MSDS) of any chemical not distributed by Applied Biosystems, contact the chemical manufacturer.
Before handling any chemicals, refer to the MSDS provided by the manufacturer, and observe all relevant precautions.
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Chapter 2 PCR Amplification

PCR work areas

Work area setup
and lab design

PCR-setup tools

Many resources are available for the appropriate design of a PCR laboratory:

For AmpF(STR® NGM™ PCR Amplification Kit forensic DNA testing, refer to:
National Institute of Justice Office of Law Enforcement Standards. 1998.
Forensic Laboratories: Handbook for Facility Planning, Design, Construction
and Moving. Washington, DC: National Institute of Justice. 76 pp.

+ For AmpF{STR® NGM™ Kit parentage DNA testing, refer to: American
Association of Blood Banks. 2004. Guidance for Standards for Parentage
Relationship Testing Laboratories. 7th ed. Bethesda, Md: American Association
of Blood Banks. 58 pp.

The sensitivity of the AmpF(STR® NGM™ Kit (and other PCR-based tests) enables

amplification of minute quantities of DNA, necessitating precautions to avoid
contamination of samples yet to be amplified (Kwok and Higuchi, 1989).

To prevent contamination by human DNA, be careful while handling and processing
samples. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: These laboratory design resources and guidances constitute only a sample of
the precautions that need to be observed when using PCR technology. Refer to your
laboratory’s internal policies and procedures for additional information and
references.

IMPORTANT! These items should never leave the PCR setup work area.

» Calculator

* Gloves, disposable

* Marker pen, permanent
* Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate clean tube (for
Master Mix preparation)

* Microcentrifuge tube rack

» Pipette tips, sterile, disposable hydrophobic filter-plugged
* Pipettors

» Tube decapper, autoclavable

* Vortex

Amplified DNA  The following GeneAmp® PCR systems should be placed in the amplified DNA

work area tools

work area.
+ Silver block 96-Well GeneAmp® PCR System 9700

+ Gold-plated silver block GeneAmp® PCR System 9700

16
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Required user-supplied materials and reagents

Required user-supplied materials and reagents

Kit contents and The AmpF(STR® NGM™ PCR Amplification Kit is available as either a
storage 200-reaction kit or 1000-reaction kit. The number of reactions is based on a 25-uLL
reaction volume. See “Kit contents and storage” on page 9 for details on kit contents.

User-supplied In addition to the AmpF(STR® NGM™ Kit reagents, the use of low TE buffer
reagents (10 mM Tris, 0.1 mM EDTA, pH 8.0) is recommended. You can prepare the buffer as
described in the procedure below or order it from Teknova (Cat # T0223).

To prepare low TE buffer:

1. Mix together:
* 10 mL of 1 M Tris-HCI, pH 8.0
* 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes based on your specific needs.

2. Aliquot and autoclave the solutions.

3. Store at room temperature.

DNA quantification

Importance of Quantifying the amount of DNA in a sample before amplification allows you to

quantification  determine whether or not sufficient DNA is present to permit amplification and to
calculate the optimum amount of DNA to add to the reaction. The optimum amount
of DNA for the AmpF(STR® NGM™ Kit is 1.0 ng in a maximum input volume of
10 uL.

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by
the instrument (“off-scale” data). Off-scale data are problematic because:

— Quantification (peak height and area) for off-scale peaks is not accurate.
For example, an allele peak that is off-scale can cause the corresponding
stutter peak to appear higher in relative intensity, thus increasing the
calculated percent stutter.

— Multicomponent analysis of off-scale data is not accurate, and it results in
poor spectral separation (“pull-up”).

» Incomplete A-nucleotide addition.

When the total number of allele copies added to the PCR is extremely low, allelic
dropout can occur, resulting in a partial profile.

AmpF&TR® NGM™ PCR Amplification Kit User’s Guide 17



Chapter 2 PCR Amplification

Methods of Applied Biosystems provides several Kits for quantifying DNA in samples. See the
quantifying DNA  references cited in the following table for details about these kits.

Product Description

References

Quantifiler® Human DNA Properties:

(%l#\lazgggzté%? Kit The Quantifiler® Human and Quantifiler® Y
Human Male Kits are highly specific for human

and DNA, and they detect total human or male DNA,

Quantifiler® Y Human Male respectively. The kits detect single-stranded and

DNA Quantification Kit degraded DNA.
(PN 4343906) How they work:

The Quantifiler® DNA Quantification Kits consist
of target-specific and internal control 5'
nuclease assays.

The Quantifiler® Human and Quantifiler® Y
Human Male Kits contain different target-
specific assays (human DNA or human male
DNA, respectively) that each consist of two
locus-specific PCR primers and one TagMan®
MGB probe labeled with FAM™ dye for
detecting the amplified sequence. The kits each
contain a separate internal PCR control (IPC)
assay that consists of an IPC template DNA (a
synthetic sequence not found in nature), two
primers for amplifying the IPC template DNA,
and one TagMan® MGB probe labeled with VIC®
dye for detecting the amplified IPC DNA.

Quantifiler® Duo DNA Properties:
Quantification Kit

(PN 4387746) The Quantifiler® Duo Kit is highly specific for

human DNA and combines the detection of both
total human and male DNA in one PCR
reaction.The kit detects single-stranded and
degraded DNA.

How it works:

The Quantifiler® Duo DNA Quantification Kit
consists of target-specific and internal control 5'
nuclease assays.

The Quantifiler® Duo kit combines two human-
specific assays in one PCR reaction (for total
human DNA and human male DNA). The two
human DNA specific assays each consist of two
PCR primers and a TagMan® probe. The
TagMan® probes for the human DNA and human
male DNA assays are labeled with VIC® and
FAM™ dyes, respectively. In addition, the kit
contains an internal PCR control (IPC) assay
similar in principle to that used in the other
Quantifiler kits, but labeled with NED™ dye.

Quantifiler® Human DNA
Quantification Kits User’s Manual
(PN 4344790)

Quantifiler® Duo DNA
Quantification Kit User's Manual
(PN 4391294)
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Prepare the amplification kit reactions

Prepare the amplification kit reactions

L.

Calculate the volume of each component needed to prepare the reactions, using
the table below.

DNA sample Volume per reaction (L)
AmpF(STR® NGM™ Master Mix 10.0
AmpF(STR® NGM™ Primer Set 5.0

Note: Include additional reactions in your calculations to provide excess
volume for the loss that occurs during reagent transfers.

Prepare reagents. Thaw the AmpF(STR® NGM"™ Master Mix and the
AmpF(STR® NGM™ Primer Set, then vortex the tubes for 3 seconds and
centrifuge them briefly before opening.

IMPORTANT! Thawing is required only during first use of the kit. After first
use, reagents are stored at 2 to 8 °C and, therefore, do not require subsequent
thawing. Do not refreeze the reagents.

Pipette the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the reaction mix for 3 seconds, then centrifuge briefly.

Dispense 15 pL of reaction mix into each reaction well of a MicroAmp® Optical
96-Well Reaction Plate or each MicroAmp® tube.

Prepare the DNA samples:
DNA sample To prepare...
Negative control Add 10 pL of low TE buffer (10mM Tris, 0.1mM EDTA, pH 8.0).
Test sample Dilute a portion of the test DNA sample with low TE buffer so

that 1.0 ng of total DNA is in a final volume of 10 uL. Add 10 puL
of the diluted sample to the reaction mix.

Positive control Add 10 uL of 007 control DNA (0.1 ng/ulL) to provide 1.0 ng of
total DNA in the positive control reaction.

The final reaction should be 25 pL.

Seal the MicroAmp® Optical 96-Well Reaction Plate with MicroAmp® Clear
Adhesive Film or MicroAmp® Optical Adhesive Film, or cap the tubes.

Centrifuge the tubes or plate at 3000 rpm for about 20 seconds in a tabletop
centrifuge (with plate holders if using 96-well plates) to remove bubbles.
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Chapter 2 PCR Amplification

Perform PCR

9. Amplify the samples in a GeneAmp™ PCR System 9700 with the silver 96-well

block, or a GeneAmp® PCR System 9700 with the gold-plated silver 96-well
block.

Note: The AmpF(STR® NGM™ Kit is not validated for use with the GeneAmp
PCR System 9700 with the aluminium 96-well block. Use of this thermal
cycling platform may adversely affect the performance of the AmpF(STR®
NGM™ Kit.

m WARNING! PHYSICAL INJURY HAZARD. Thermal cycler.

. Program the thermal cycling conditions.

IMPORTANT! When using the GeneAmp PCR System 9700 with either 96-well
silver or gold-plated silver block, select the 9600 Emulation Mode.

Initial Cycle (29 cycles) Final Final

incubation step Denature ‘ Anneal extension hold

HOLD CYCLE HOLD HOLD
95 °C 94 °C 59 °C 60 °C 4°C
11 min 20 sec 3 min 10 min )

. Load the plate or tubes into the thermal cycler and close the heated cover.

IMPORTANT! If using adhesive clear film instead of caps to seal the plate wells,
be sure to place a MicroAmp® compression pad (PN 4312639) on top of the
plate to prevent evaporation during thermal cycling.

. Start the run.

. On completion of the run, store the amplified DNA and protect from light.

If you are storing the DNA... Then place at...
< 2 weeks 2to8°C
> 2 weeks -15t0o25°C

IMPORTANT! Store the amplified products so that they are protected from light.

20
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Amplification using bloodstained FTA® cards

Amplification using bloodstained FTA® cards
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FTA® cards can be useful for the collection, storage, and processing of biological
samples. A small punch disc of the card containing the sample can be placed directly
into an amplification tube, purified, and amplified, without transferring the disc.
Applied Biosystems studies indicate that a 1.2-mm bloodstained disc contains
approximately 5 to 20 ng DNA. An appropriate cycle number for this high quantity
of DNA is 24 cycles, determined by Applied Biosystems validation studies.
However, it is recommended that each laboratory determine the optimum cycle
number based on internal validation studies.

In the example shown in Figure 4, a 1.2-mm disc of a bloodstained FTA card was
purified using three washes with FTA Purification Reagent and two washes with

1X low TE buffer. The punch was then amplified directly in the MicroAmp® tube for
24 cycles.

50 190 230 am 10 350

(Y

Figure 4 AmpF(STR® NGM™ PCR Amplification Kit results from a 1.2-mm FTA
bloodstain disc (24-cycle amplification), analyzed on the Applied Biosystems
3130x/ Genetic Analyzer
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Electrophoresis

This chapter covers:

B Allelic ladder requirements . . .. .....ou ittt 28

Section 3.1 3100/3100-Avant and 3130/3130xl instruments ............. 29
m Set up the 3100/3100-Avant or 3130/3130x1 instrument for electrophoresis . 29
B Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130xl1
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Chapter 3 Electrophoresis

Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples. For samples run on the:

+ ABI PRISM® 310 Genetic Analyzer: Run at least one allelic ladder for every 10
sample injections.

+ ABI PrisM® 3100 and Applied Biosystems 3130 series Genetic Analyzers: Run
at least one allelic ladder per every set of 16 samples.

IMPORTANT! Variation in laboratory temperature can affect fragment
migration speed and result in sizing variation. Applied Biosystems recommends
the following frequency of allelic ladder injections; this frequency should
account for normal variation in run speed. However, during internal validation
studies, verify the required allelic ladder injection frequency to ensure accurate
genotyping of all samples in your laboratory environment.

— Applied Biosystems 3130x/ or ABI PRISM® 3100 systems — One ladder per
injection; one injection = 16 samples (15 samples + 1 allelic ladder)

— Applied Biosystems 3130 or ABI PRISM® 3100-4vant — One ladder for
every 4 injections; one injection = 4 samples

When genotyping, it is critical to use an allelic ladder run under the same conditions
as the samples because:

» Size values obtained for the same sample can differ between instrument
platforms because of different polymer matrices and electrophoretic conditions.

* Variation in laboratory temperature can affect migration speed (see
IMPORTANT above). These variations can result in sizing variations between
both single and multiple capillary runs, with a greater size variation between
those samples injected in multiple capillary runs, than between those samples
injected in a single capillary run.
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Section 3.1 Electrophoresis

Section 3.1 3100/3100-Avant and 3130/3130x/

instruments

Set up the 3100/3100-Avant or 3130/3130x/ instrument for

electrophoresis

Reagents and

parts

3100/3100-Avant

Table 5 on page 10 lists the required materials not supplied with the AmpF(STR®

NGM™ PCR Amplification Kit.
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IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the AmpF(STR® NGM™ Primer Set from light when not in use. Amplified
DNA, AmpF(STR® NGM™ Allelic Ladder, and GeneScan™ 500 LIZ® Size Standard
should also be protected from light. Keep freeze-thaw cycles to a minimum.

The following table lists Data Collection Software and the run modules that can be

or 3130/3130x/ used to analyze AmpF{STR® NGM™ Kit PCR products. For details on the
instrument procedures, refer to the documents listed in the table.
requirements
Data Operatin
Collection g ste mg Run modules and conditions References
Software y
3.0% Windows ¢ HIDFragmentAnalysis36_POP4_1 Applied Biosystems 3130/3130x/ Genetic
(3130/3130x/ = XP Injection conditions: Analyzers Using Data Collection Software
Analyzer) 3130 = 3 KV/5 v3.0, Protocols for Processing AmpF&TR
- = Sec PCR Amplification Kit PCR Products User
— 3130x/ =3 kV/10 sec Bulletin (PN 4363787)
e Dye Set G5
2.0 Windows e HIDFragmentAnalysis36_POP4_1 ABI PrisM® 3100/3100-Avant Genetic
(3100 2000 Injection condition: 3kV/10 sec Analyzers Using Data Collection Software
Analyzer) o Dve Set G5 v2.0, Protocols for Processing AmpF&TR
ye o€ PCR Amplification Kit PCR Products User
Bulletin (PN 4350218)
1.1 Windows ¢ GeneScan36vb_DyeSetG5Module = ABI PRISM® 3100/3100-Avant Genetic
(3100 NT® Injection condition: 3kV/10 sec Analyzers Protocols for Processing
Analyzer) e GS500Analvsi AmpF&STR PCR Ampilification Kit PCR
nalysis.gsp Products User Bulletin (PN 4332345)
1.0 Windows ¢ GeneScan36Avb_DyeSetG5Module = ABI PRISM® 3100/3100-Avant Genetic
(3100-Avant = NT® Injection condition: 3 kV/5sec Analyzers Protocols for Processing
Analyzer) e GS500Analvsi AmpF&TR PCR Amplification Kit PCR
nalysis.gsp Products User Bulletin (PN 4332345)

1 Applied Biosystems conducted validation studies for the AmpF(STR® NGM™ Kit using this configuration.
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Section 3.1 Electrophoresis

Prepare samples for electrophoresis on the 3100/3100-
Avant or 3130/3130x/ instrument

Prepare the samples for electrophoresis on the 3100/3100-Avant or 3130/3130x!/
instrument immediately before loading.

1.

10.

Calculate the volume of Hi-Di"™ Formamide and GeneScan"™ 500 LIZ® Internal
Size Standard needed to prepare the samples, using the table below.

Reagent Volume per reaction (uL)
GeneScan 500 LIZ Size Standard 0.3
Hi-Di Formamide 8.7

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results/experiments.

. Pipette the required volumes of components into an appropriately sized

polypropylene tube.
Vortex the tube, then centrifuge briefly.

Into each well of a MicroAmp® Optical 96-Well Reaction Plate, add:
* 9 uL of the formamide:size standard mixture
e 1 pL of PCR product or allelic ladder

Note: For blank wells, add 10 uL of Hi-Di"™" Formamide.

Seal the reaction plate with appropriate septa, then centrifuge the plate to ensure
that the contents of each well are collected at the bottom.

Heat the reaction plate in a thermal cycler for 3 minutes at 95 °C.

Immediately place the plate on ice for 3 minutes.

. Prepare the plate assembly, then place onto the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

Start the electrophoresis run.

30
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Chapter 3 Electrophoresis

Section 3.2 310 Instrument

Set up the 310 instrument for electrophoresis

Reagents and  Table 5 on page 10 lists the required materials not supplied with the AmpF(STR®

parts NGM™ PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.

Protect the AmpF(STR® NGM™ Primer Set from light when not in use. Amplified
DNA, AmpF(STR® NGM™ Allelic Ladder, and GeneScan™ 500 LIZ® Size Standard
should also be protected from light. Keep freeze-thaw cycles to a minimum.

310 instrument  The following table lists Data Collection Software and the run modules that can be
requirements used to analyze AmpF(STR® NGM™ Kit PCR products. For details on the
procedures, refer to the documents listed in the table.

References

Data .
Collection Og esrﬁ:::g Run modules and conditions
Software Yy
3.1% Windows XP | GS STR POP4 (1mL) G5 v2.md5
or or Injection condition:
3.0i Windows 15 kV/5 sec
NT® and
Windows
2000

ABI PrisM® 310 Genetic Analyzer User’s Manual
(Windows) (PN 4317588)

ABI PRisM® 310 Protocols for Processing
AmpF(STR PCR Amplification Kit Products with
Microsoft Windows NT Operating System: User
Bulletin (PN 4341742)

1 Applied Biosystems conducted concordance studies for the AmpF(STR® NGM™ Kit using this configuration.
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Section 3.2 Electrophoresis

Prepare samples for electrophoresis on the 310 instrument

Prepare the samples for capillary electrophoresis on the 310 instrument immediately
before loading.

1.

10.

Calculate the volume of Hi-Di"" Formamide and GeneScan'" 500 LIZ® Internal
Size Standard needed to prepare the samples, using the table below.

Reagent Volume per reaction (uL)
GeneScan 500 LIZ Size Standard 0.75
Hi-Di Formamide 24.25

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.

Pipette the required volumes of components into an appropriately sized
polypropylene tube.

. Vortex the tube, then centrifuge briefly.

Into each 0.2-mL or 0.5-mL sample tube, add:
o 25 uL of the formamide:size standard mixture
e 1.5 pL of PCR product or allelic ladder

Note: For blank wells, add 10 uL of Hi-Di™ Formamide.

Seal the tubes with the appropriate septa, then briefly centrifuge to ensure that
the contents of each tube are mixed and collected at the bottom.

Heat the tubes in a thermal cycler for 3 minutes at 95 °C.
Immediately place the tubes on ice for 3 minutes.

Place the sample tray on the autosampler.

Ensure that an injection list is prepared.

Start the electrophoresis run.
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Section 4.1 GeneMapper® ID Software

Before you start  GeneMapper® ID Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis. After electrophoresis, the Data
Collection Software stores information for each sample in a .fsa file. Using
GeneMapper® ID Software v3.2.1 software, you can then analyze and interpret the
data from the .fsa files.

Note: Refer to “Instrument and software overview” on page 7 for a list of
compatible instruments.

When using GeneMapper® ID Software v3.2.1 to perform human identification
(HID) analysis with AmpF(STR® kits, be aware that:
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« HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided that you
conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a
run folder.

* Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

» Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

* Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

* Alleles that are not in the AmpF¢STR® Allelic Ladders do exist. Off-ladder
(OL) alleles may contain full and/or partial repeat units. An off-ladder allele is
an allele that occurs outside the +0.5-nt bin window of any known allelic ladder
allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory’s protocol.

If you are using GeneMapper /D-X Software to perform Human Identification (HID)
analysis with AmpF{STR Kkits, go to “Set up GeneMapper® ID-X Software for data

analysis” on page 54 or refer to the GeneMapper® ID-X Software Version 1.0 Human
Identification Analysis Getting Started Guide (PN 4375574).
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Section 4.1 Data Analysis

Set up

GeneMapper® ID
Software for data

analysis

Workflow

To analyze sample (.fsa) files using GeneMapper® ID Software v3.2.1 for the first
time:

Import panels and bins into the Panel Manager, as explained in “Import panels
and bins” on page 40.

Import an analysis method, as explained in “Import a HID analysis method”
on page 43.

Import a size standard, as explained in “Import a HID size standard” on
page 48.

Define custom views of analysis tables.

Refer to Chapter 1 of the GeneMapper® ID Software Versions 3.1 and 3.2
Human Identification Analysis Tutorial (PN 4335523) for more information.
Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID Software Versions 3.1 and 3.2
Human Identification Analysis Tutorial (PN 4335523) for more information.

Import panels and bins

To import the AmpF(STR® NGM™ Kit panel and bin set from the
Applied Biosystems web site into the GeneMapper® ID Software v3.2.1 database:

1.

Download and open the file containing panels and bins:

a. From the Support menu of www.appliedbiosystems.com, select
Support » Software Downloads, Patches & Updates » GeneMapper® ID
Software v 3.2 » Updates & Patches, and download the file NGM
Analysis Files GMID.

b. Unzip the file.

2. Start the GeneMapper® ID Software, then log in with the appropriate user name

3.

and password.

IMPORTANT! For logon instructions, refer to page 2-7 of the GeneMapper® ID
Software Version 3.1 Human Identification Analysis User Guide (PN 4338775).

Select Tools » Panel Manager.

40
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4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

f_::;PanEI Manager
File Edit Bins “iew

=5 Il 0 N M |

== Panel Manager

Highlight this.
|

b. Select File » Import Panels to open the Import Panels dialog box.

c. Navigate to, then open the NGM Analysis Files GMIDX folder that you
unzipped in step 1 on page 40.
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5. Select NGM_panel_v1, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the
Panel Manager, AmpFLSTR_NGM_v1. This folder contains the panel and

associated markers.

(™ lImport Panels ) |

Loaok in: Il:l MM Analysizs Fies Ghil

=) CE_G5_MGh_GSE00 xml
2 MGK_AnalysisMethod w1 xml

MG _bins_wl tet

Recent

Desktap

- File narme: INGMJ&aneI_ﬂ tat Import |
el Files of type: IAII File= LI Cancel |

6. Import NGM_bins_v1:
a. Select the AmpFLSTR_NGM_vl1 folder in the navigation pane.

(¥ JPanel Manager
File Edit Bins Wiew

Panel Hare Coptirierd

== Panel Manager
[J&mpFLSTR Panels_w1 |1 NGM_panel_v1 |t

B ArpFLSTR_NGM v

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
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Section 4.1 Data Analysis

c. Navigate to, then open the NGM Analysis Files GMID folder.

d.

Select NGM_bins_vl, then click Import.

Note: Importing this file associates the bin set with the panels in the
NGM_panel_vl1 folder.

2] CE_5_MGM_GS500 xml

MEh_Analysistethod el cml
=hd_k Tt

MGM_panel_wl tet

File name: INGM_bins_ﬂ It Irmpart |
Filez of type: IA" File= ll Cancel |

a.

7. View the imported panels in the navigation pane:

Double-click the AmpFLSTR_NGM_v1 folder to view the
NGM_panel_v1 folder.

Double-click the NGM_panel_v1 folder to display the panel information
in the right pane.

Panel Manager

Filz Edit Bins ‘iew

R e — L I S
== Panel Manager Bolardcer Hame Irye Color | Bl Bize MaxTne Comtrol Aleles Mlardcer ¥ | Bolardcer § | Corromerits Ladder Alleles
ClampFLSTR_Panels w1 |1 [pi0s1z4s | biue 72.0 1270 Mz15 4 0115 |nane 89,1011 12131415 16,17
=S AmpFLETR_MGM_v1 2 |vmin, blue 1490 243 |M416" 4 0126 |nane 11121314 151647 16,13,
=2 ' s ! 3 |D1B5539 blue 2236 |2FPE  "9a0 4 0104 |nane 5,6,3101112,131415
L e 4 |D251336 blue 206 (3560|2023 4 012 |none 15,16,1716,19,20, 21 22,23,
DM ES539 5 |AMEL green 1000 [108.0 "yt g 00 |none s
- D2s1338 £ |D8S1179 green  |117.9 1749|213 4 0.1 nohe 8,9,10,11,1213,141516,17
B S;”;L1 T 7 |D2En green 1788 (2498  |"28,31" 4 041 |nane 24,24 2,25 76,27 26 25.2,29
s 5 |D18ss green 2505|3475 [4215 4 017 |nane 7.91040.211,121313.2,1¢
D ES5 9 |D2251045 yellow | 76.0 1200 1,15 3 0155 |nane 89,1011 ,1213,141516,17
- D22s1045 10 |D195433 yellowe (1223 1663 415" 4 0133 |hone 910,11,121221313.2,14;
B ?:315433 11 |THO yellow 1764 2211|793 4 0051 |none 4,56,789931011133
Lo ! 12 [FGA, yellow (2216 [3720  |"24 26" 4 0147 |nane 17,16,19,20,21 22,23 24,25,
— D2Sdd 13 |D25441 red 745 134 ™45 4 0085 |nane 910,11,11.312,1314 1516
- D331358 14 |D3S1356 red 1144 1684  |M516" 4 0115 |none 121314151617 16,19
B 31 3;2:? 15 |D151656 red 1700 (2240 ™36 4 012 |nane 910,11,1213,1414.315,15
16 |D12530 red 2250 (2870 819 4 016 |none 14,15,1617,15,19,19.3,20,2
— = Reference Samples
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| /Panel Manager

File Edit Bins \iew

8. Select D10S1248 to display the Bin view for the marker in the right pane.

TR LI

E—ﬁ MGM_panel w1

— s,
—D165533
D233
— AMEL

- Das1179
—D21511
D1 EsE
—D2251045
D1 25433
— THO1
PG,
—D2544
D335
—D151656
L D125391
4| | »

1 | |Bin Set: INGM_binS_v1

—=IReference Samples

o4

0a

o7

06

0.:

0.4

03

0z

01

oo
EY 1 7o ] a3 a7 a1 a3 a9 103 a7 111 113 114 123 127 13

LA051245

14 |l

O | Cancel | Apply |

9. Click Apply, then OK to add the AmpF(STR® NGM™ Kit panel and bin set to
the GeneMapper® ID Software database.

IMPORTANT! If you close the Panel Manager without clicking OK, the panels
and bins are not imported into the GeneMapper® ID Software database.

Import a HID analysis method

The HID Advanced analysis method for the AmpF(STR® NGM™ Kit uses the
NGM_bins_vl file described in step 6 on page 41.

Use the following procedure to import the analysis method from the folder that you
downloaded from the Applied Biosystems web site into the GeneMapper® ID
Software database. Refer to step 1 on page 40 for downloading instructions.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
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Section 4.1 Data Analysis

2. Import an analysis method for HID_Advanced:

a. Select the Analysis Methods tab, then click Import.

f_l__;;GeneMapper Manager

| dnalysis Methods || Tale Settings | Plot Settings | Matrices | Size Standards
Matne Last Saved Orwvner Instrurnerit Analysis Type Dezcription

HID_&dvanced 2009-06-18 16:22:2 | grnid HID i
HID_Classic 2007-05-06 10:03:0 | grmic HIC
Microsatelite Default 2004-05-25 11:34:3 | genid Mictosatelite Factary Pravided

b. Navigate to, then open the NGM Analysis Files GMID folder.

3. Select NGM_AnalysisMethod_v1, then click Import to import the
NGM_AnalysisMethod_v1 into the GeneMapper® ID Software database.

mport Analysis Method

Loak ir: II:I rGH Analysiz Files GMID

= CE_G5_MGM_GS500.xm

File name: INGM_.ﬂ.nalvsisMethu:ud_ﬂ i IFrifport |
Files 0f type:  fOuL Files (7 xmi) v|  cancel |
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View HID Analysis Method Editor tab settings

To view the settings for NGM_AnalysisMethod_v1, select the Analysis Methods
tab, then select NGM_AnalysisMethod_v1 in the Name column and click Open.

_:" GeneMapper Manager I 1[
Frojects Analysis Methods | Taple Settings | Plot Seﬂingsl Matricesl Size Standards
Mame Laszt Zaved Cryrer Instrumert Analysis Type Descripti
HID_Clas=ic 2007-03-05 10:03:0| gmid HIC: E
Microsatelite Defaut 2004-05-2811:34:3  grid Microzatellite Factary
MGM_Analysishlethod_w»1 | 2003-04-15 1:3:55:5 amid HID: GMID w3

)
@
>
[0}
=
Q
e}
O
o
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»
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=
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Figure 5 Analysis Method Editor - HID: General tab settings

Figures 6 through 9 show the settings for each tab of the Analysis Method Editor -
HID.

x
General  Allsl: | Peak Detec:torl Peak Gual'rtyl Guality Flags |
Bin =et:
v Use marker-zpecific stutter ratia if available
Warker Fepeat Type Tri Tetra Perta Hexa
Cut-off Walue jo.o jo.o jo.o jo.o
Minuis2, Fatio jo.o jo.o jo.o jo.o
Minus Distance From 0.0 o0 oo o0
To oo oo o0 oo
Minus Stutter Ratio oo oo oo oo
Minus Stutter Distance  From  [2.25 .25 jo.o jo.o
To [375 fa.75 jo.o jo.o
Plus Stutter Ratio o0 o0 o0 o0
Plus Stutter Distance ~ From |00 oo oo oo
To oo jo.o jo.o jo.o
Arnelogenin Cutoff Ig_n
Range Fiter... | Factary Defaults |
CK | Cancel |

Figure 6 Analysis Method Editor - HID: Allele tab settings
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Section 4.1 Data Analysis

+ GeneMapper® ID Software v3.2.1 allows you to specify four types of marker
repeat motifs: tri, tetra, penta, and hexa. You can enter parameter values for each
type of repeat in the appropriate column.

» The “Use marker-specific stutter ratio if available” check box is selected by
default. Consequently, the software applies the stutter ratio filters supplied in
the NGM_panel_vl1 file.

Analysis Method Editor - HID x|

General | Allsle  Peak Detector | peak quality | Gusity Flags |

Peak Detection Algorithrm: I.&dvanced LI
Ranges Peak Detection
Ariahysis Sizing Peak Amplitude Thresholds:
Full Range LI IAII Sizes LI B: ITBD R I TBD
=tant P 2500 =tant Sizedsi
e — e |TBD o |TBD

Stop Pt 10000 Stop size400
: ¥ I TBD

Smoothing and Baselining -
Mif. Peak Half Width: |2 pt=
Stnoothing " Mane I—
: : 5
o Light Palynarmial Degree:
" Heawy Peak Window Size: 15 pt=
Bazelineg Windoww: |51 pt= Slope Threshold
L Peak Start: I':'-':'

—=ize Calling Method I e st ID.EI

" 2nd Order Lesst Souares
* 3rd Order Least Souares
" Cubic Spline Interpolstion
" Local Southern Method
" Global Southern Method

Factory Defaults |

8] | Cancel |

Figure 7 Analysis Method Editor - HID: Peak Detector tab settings

IMPORTANT! Laboratories need to perform the appropriate internal validation
studies to determine the peak amplitude thresholds that allow for reliable
interpretation of AmpF(STR® NGM™ Kit data.

The software uses the peak amplitude threshold parameters to specify the minimum
peak height to limit the number of detected peaks. Although GeneMapper® ID
Software displays peaks that fall below the specified amplitude in
electropherograms, the software does not label or determine the genotype of these
peaks.
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Analysis Method Editor - HID x|

General | Alsle | Pesk Detector  Pesk Qualty | cualty Flags |

—Eignal lenvel

Homozygous min peak height I TBD
Heterozygous min peak height I TBD

~Heterozygote balance

it pesak hieighit ratio ID.?
—Peak morphology

Max pesk width (basepairs) |1 )

~Pull-up pesk
Pull-ug ratio 0.03

~Allele number

Max expected alleles |2

)
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O Cancel

Figure 8 Analysis Method Editor - HID: Peak Quality tab settings

IMPORTANT! Laboratories need to perform the appropriate internal validation
studies to determine the minimum heterozygous and homozygous minimum peak
height thresholds and the minimum peak height ratio threshold that allow for reliable
interpretation of AmpF(STR® NGM™ Kit data.
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Section 4.1 Data Analysis

Analysis Method Editor - HID x|

ceneral | llele | Pesk Detector | Peak Gualty  @uality Flags |

Guality weights are between 0 and 1.
Gality Flag Settings

Spectral Pull-up [os Cortrol Concordance 1o
Eroad Peak IF Lowy Peak Height F
Ot of Bin Allels [os Off-seale [z
Overlap e Peak Height Ratio [

Py Threshaolds

Pazz Range: Loy Guality Rance:
Sizing Guality: From ID.?S tod.0 FromO.0to (025
Genotype Guality: From |0.75 ta1.0 Fram 00t 025
Factory Defauts |
oK | Cancel |

Figure 9 Analysis Method Editor - HID: Quality Flags tab settings

Import a HID size standard

The size standard for the AmpF(STR® NGM™ PCR Amplification Kit uses the
following GS500 peaks in its sizing algorithm: 75, 100, 139, 150, 160, 200, 300, 350,
400, and 450.

Use the following procedure to import the size standard for the AmpF(STR® NGM™
Kit from the folder that you downloaded from the Applied Biosystems web site, into
the GeneMapper® ID Software database. Refer to step 1 on page 40 for downloading
instructions.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

2. Import a size standard:

a. Select the Size Standards tab, then click Import.
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f,:'_;GeneMapper Manager

Projects | Srelysis Methods | Table Settings | Plot Settings | Matrices |
|Name |Las‘f Saved |Owner |Type |Descrip‘finn
377 _F_HID_G=500 2004-05-25 11:34:3 | grnid EBazic/Advanced Factory Provided | *
CE_G5_HID_G=:500 2004-05-25 11:34:3 | grnidd Basic/Advanced Factory Provided
CE_F_HID_G=500 2004-05-25 11:34: 3 genicd Basziciidvanced  Factory Provided

Delete

ey CREr... SEvE L. Irpart.... Export... |

Done

b. Navigate to, then open the NGM Analysis Files GMID folder.

3. Select CE_G5_NGM_GS500, then click Import to import the
CE_G5_NGM_GS500 size standard into the GeneMapper® ID Software

database.

mport Size Standard Method | |

Look ir: I[:I MG Analysiz Files GhID

MG _Analysistethod w1 xmil

o
=l

File name: ICE_GS_NGM_GSSDD.me Irport |
Files of type: I}(ML Files: (% i) Rd| Cancel |

Analyze and edit Analyze a project

sample files with
GeneMapper® ID 1. In the Project window, select File » Add Samples to Project, then navigate to

Software the disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings
Sample Type Select the sample type.
Analysis Method NGM_AnalysisMethod_v1
Panel NGM_panel_v1
Size Standard CE_G5_NGM_GS500

¢ Size Standard: For more information about how the Size Caller works,
refer to the ABI Prism® GeneScan® Analysis Software for the Windows
NT® Operating System Overview of the Analysis Parameters and Size
Caller User Bulletin (PN 4335617).

AmpF&STR® NGM™ PCR Amplification Kit User’s Guide
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Section 4.1 Data Analysis

* CE_G5_NGM_GS500 (size standard fragments defined in the
AmpF(STR® NGM™ Kit): 75, 100, 139, 150, 160, 200, 300, 350, 400, and
450. For additional information about size standards, refer to the

GeneMapper® ID Software Version 3.1 Human Identification Analysis
User Guide (PN 4338775), Appendix D.

* CE_G5_NGM_GS500: Neither the 250-nt nor the 340-nt peak is included
in the size standard definition. These peaks can be used as an indicator of
precision within a run.

3. Click ¥ (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

» The status bar displays the progress of analysis:

— As a completion bar extending to the right with the percentage
completed indicated

— With text messages on the left

» The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

* The Genotypes tab becomes available after analysis.

!E:}GeneMapper ID ¥3.2.1 - *Untitled - gmid Is Logged In

Fil= Edit A&nalysis Miew Tools Help

=0 -0l x|

[11 H =1l || > & HTabIESEﬂingHIHIDTabIE

~E 08|~

Satrple File

| Cersbus 012009,

Cerebus_012003,
Cerebuz_012009,
Cerebus_012009,
Cerebus_012009

Cerebus_012003,
Cerebus_01 2008 |

|Cerebus 012008,
|Cerebus_012008,

Cerebus_012009
Cerebus_012003,
Cerebus_012003,
Cerebuz_012009,
Cerebus_012009,

| Cerebus_012009

Sarmple Marme
IB_0001
IFi_0002
I6_0003
IE_0004
IB_0005
IB_0006
IE_0007
IE_0005
IE_0009
E_0010
IB_0011
IE_0012
IB_0013
IE_0014
Lacder

Sample Type
Sample
Sample
Sarmple
Sarmple
Sample
Sarmple
Sahple
Sarmple
éample
Sample
Sarmple
Sample
Sarmple
Sarmple
Allelic Ladder

Analysiz Method

MNGM_AnalysisMethod
GM_AnalysizMethod
MG _&nalysishethod
MGM_Snalysishethod
MG _LnalysisMethod
MG _&nalysisMethod
MEGM_&nalysisMethod
MGM_&nalysishethod
HGM_tnalysishethod
NGM_Analysishiethod
MG _&nalysisMethod
MGM_&nalysistethod
MG _&nalysishethod
MGM_Analysishethod
NGM_AnalysisMethod

Panel

MGM_pansl_t
.NGMJ]EFIELV‘I
MG _panel_w1
MG _pansl_w1
MG _pansl_w1
MG _pansl_v1
NGMJ]anEI_v1
MG _panel_w1
HGM_pansl_v1
.NGMJJanBLV‘I
MG _pansl_v1
MG _panel_v1
MG _panel_w1
MG _pansl_w1
HGM _panel_w1

Size Standard

CE_(:5_NGM_GS500
CE_(35_NGM_GSS00
CE_G5_NGM_55500
CE_G&_NGM_GSs00
CE_G5_NGM_GS500
CE_(:5_NGM_GS500
CE_G5_NGM_GE500
CE_G5_NGM_G5500
CE_G&_NGM_GSs00
CE_G5_WGM_GS500
CE_(:5_NGM_GS500
CE_G5_NGM_GE500
CE_G5_NGM_55500
CE_GE_NGM_GS500
CE_G5_NGM_GS500

Run Matne

2005-01-20_C | 4EI5130
2009-01-20_C|ABI3130
2009-01-20_C | ABI3130
2009-01-20_C ABI31 30
2009-01-20_C | ABI3130
2005-01-20_C | 4EI5130
2009-01-20_C|ABI3130

2009-01-20_C| 8813130

2009-01-20_C | ABIF130
2009-01-20_C | ABI3130
2003-01-20_C | ABI3130
2009-01-20_C|ABI3130
2009-01-20_C | ABI3130
2009-01-20_C | ABIF130

Instrumert Type
2008-01-20_C | ABI31 30

o= G| BB
[=-EIProject Samples I
F-{2008-M-20 e |
-
5 !h
3 pq
-
s
5 |
7 rm
ECS
|9 l'w
10
1" |
2 |
(13 |
M
s
1|
K| o

Progress Status ..

0%

Figure 10 Project Window before analysis

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of
the Project window (assuming the analysis is complete).
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For more For details about GeneMapper® ID Software features, allele filters, peak detection
information  algorithms, and project editing, refer to:

»  GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis
Tutorial (PN 4335523)

»  GeneMapper® ID Software Version 3.1 Human Identification Analysis User
Guide (PN 4338775)

s Installation Procedures and New Features for GeneMapper® ID Software
Version v3.2 User Bulletin (PN 4352543)
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52 AmpFSTR® NGM™ PCR Amplification Kit User’s Guide



Chapter 4 Data Analysis

Section 4.2 GeneMapper® ID-X Software

Before you start

GeneMapper® ID-X Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis. After electrophoresis, the Data
Collection Software stores information for each sample in a .fsa file. Using
GeneMapper® ID-X Software v1.0.1 or higher, you can then analyze and interpret the
data from the .fsa files.

Note: Refer to “Instrument and software overview” on page 7 for a list of
compatible instruments.

When using GeneMapper® ID-X Software v1.0.1 or higher to perform human
identification (HID) analysis with AmpF(STR® kits, be aware that:

* HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided that you
conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a
run folder.

* Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

* Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

* Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

 Alleles that are not in the AmpF¢STR® Allelic Ladders do exist. Off-ladder
(OL) alleles may contain full and/or partial repeat units. An off-ladder allele is
an allele that occurs outside the +0.5-nt bin window of any known allelic ladder
allele or virtual bin.

Q)
o)
>
o)
<
Q
o
o)
o
)
v
>
(7]
o)
=
=
=
o

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory’s protocol.
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Section 4.2 Data Analysis

Set up GeneMapper® ID-X Software for data analysis

Workflow To analyze sample (.fsa) files using GeneMapper® ID-X Software v1.0.1 or higher
for the first time:

* Import panels, bins, and marker stutter into the Panel Manager, as explained in
“Import panels, bins, and marker stutter” on page 54.

* Import an analysis method, as explained in “Import an analysis method” on
page 59.

* Import a size standard, as explained in “Import a HID size standard” on
page 63.

* Define custom views of analysis tables.
Refer to Chapter 1 of the GeneMapper® ID-X Sofiware Version 1.0 Getting
Started Guide (PN 4375574) for more information.

* Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting
Started Guide (PN 4375574) for more information.

Import To import the AmpF{STR® NGM™ Kit panels, bin sets, and marker stutter from the
panels, bins, and  Applied Biosystems web site into the GeneMapper® ID-X Software v1.0.1 or higher
marker stutter database:

1. Download and open the file containing panels, bins, and marker stutter:

a. From the Support menu of www.appliedbiosystems.com, select
Support » Software Downloads, Patches & Updates » GeneMapper® ID
Software v 3.2 » Updates & Patches, and download the file NGM
Analysis Files GMIDX.

b. Unzip the file.

2. Start the GeneMapper® ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to page 22 of the GeneMapper® ID-
X Software Version 1.0 Getting Started Guide (PN 4375574).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

g* Panel Manager

File Edit Bins Wiew Help

L

I— Highlight this.
B R
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Set up GeneMapper® ID-X Software for data analysis

b. Select File » Import Panels to open the Import Panels dialog box.
c. Navigate to, then open the NGM Analysis Files GMIDX folder that you
unzipped in step 1 on page 54.
5. Select NGM_panel_v1X, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the
Panel Manager “AmpFLSTR_NGM_v1X”. This folder contains the panel and

associated markers.

#* Import Panels I x|

Lackini |5 NGM Analysis Files GMIDX R G S s =

CE_G5_MiEM_ 5500, xml

MGk _AnalysisMethod w1, xml
[Z] MEM_bins_w1s.kxt
‘B naM_panel_v 0
[Z] mMEM_stutter_vix.bxt

File name: |NGMJ3ane|_v1><.txt Impork |
Files of bype: |p||| Files LI Cancel |

My Documents

6. Import NGM_bins_v1X:
a. Select the AmpFLSTR_NGM_v1X folder in the navigation pane.

g* Panel Manager

Eile Edit Eins Yew Help

i 3 | F B OB | W= | einset oM bins_vix =1
—

= d_%ﬁpa"'e' Manager |Paml Harme Contirmert.
~[C)AmMPFLSTR_Panels_vix |1 JAGM_panel vix rll

JE30 ) i pFLS TR MG vl

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the NGM Analysis Files GMIDX folder.
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Section 4.2 Data Analysis

d. Select NGM_bins_v1X, then click Import.

Note: Importing this file associates the bin set with the panels in the

NGM_panel_v1X folder.

p* Import Bin 5et ] ﬂ

Look in: I[h MGM Analysis Files GMIDE

x| 2=

him

File nanie:

Files of type:

[Z] MGEM_panel_wid.tet
[Z] MGEM_skutker _v1X.bxt

CF_G5_MGM_E5500,%ml
MGEM_Analysistethod w1, xml

|rGM_bins_v 1. xt

Irnpark |

|.n|| Files

LI Cancel |

7. View the imported panels in the navigation pane:

a.

Double-click the AmpFLSTR_NGM_v1X folder to view the

NGM_panel_v1X folder.

Double-click the NGM_panel_v1X folder to display the panel information
in the right pane and the markers below it.

#* Panel Manager ]

File Edit Bins Mew Help

iy D¢ | FEE | [ ] |BinSet: INGM_bins_le

W wExE | AEEEEE | e

[ g3, Panel Manager

s [CAMPFLSTR_Panels_v1%

[ AmpFLSTR_MGM_y
2]

- D165539
- D251338
- BMEL

- DAS1179
- D21511

- D18S51

- D2251045
- D195433
- THOL

- FGA

- D25441

- D351358

£ D151656
[ 0125391

------ i Reference Samples

Mlarker Hunmie Dnpe Color | Bl Size | Blac Sime | Cordrol Alleles Marker | Cooramerits Ladder Alleles
1 piosizas Blue 72.0 127.0 [12,15 4 none ,9,10,11,12,13,14,15,16,17,16
2 |vWa Blue 149.0 (2143 [14,16 4 none 11,12,13,14,15,16,17,18,19,20,21,22,27
3 [D16S539 Blue A6 276 (9,10 4 none 5,8,9,10,11,12,13,14,15
4 [D251338 Blue E16  3EE.0 (20,23 4 none 15,16,17,18,19,20,21,22,23,24,25,26,27
5 AMEL Green 100.0 105.0 AT 9 none ER
& |DES1179 Green (1179 (1749 [12,13 4 none ,9,10,11,12,13,14,15,16,17,18,19
7 |Dz1511 Green 1788 2498 |28,31 4 none 24,24,2,75,26,27,28,28,2,29,29,2,30,30
8 [D18551 Green (2595 (3475 [12,15 4 none 7,9,10,10,2,11,12,13,13.2,14,14.2,15, 1t
9 |D2251045 vellow  [76.0 1200 |11,16 3 none ,9,10,11,12,13,14,15,16,17,18,19
10 |D195433 vellow (1223 1663 |14,15 4 none 9,10,11,12,12,2,13,13.2,14,14.2,15,15.;
11 |THOL vellow (1764 (2211 [7,9.3 4 none 4,5,6,7,8,9,9,3,10,11,13.3
12 |FGA velow (2216 (3720 (24,26 4 none 17,18,19,20,21,22,23,24,25,26,26.2,27,
13 |D25441 Red 74.5 113.4 (14,15 4 none 9,10,11,11,3,12,13,14,15,16
14 |D3s1358 Red 1144 1684  [15,16 4 none 12,13,14,15,16,17,15,19
15 |D151656 Red 1700 (2240 [13,16 4 none 9,10,11,12,13,14,14.3,15,15.3,16,16.3,:
16 |D125391 Red 225.0 [287.0 (18,19 4 none 14,15,16,17,18,19,19,3,20,21,22,23,24,
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Set up GeneMapper® ID-X Software for data analysis

8. Select D10S1248 to display the Bin view for the marker in the right pane.

#* Panel Manager x|
File Edit Bins Mew Help
o 5 | BB | (B | BinSe: oM bins_vix ML ERE | IEEEEE| o

- siuPanel Manager
= d%"‘ g iq 7 g a 0 11 12 12 14 15 A6 17 12 19 20

0.3

0.3

o7

06

0.3

0.4

0125391

0.3

------ i Reference Samples

0.z

01

0.0
BT B3 71 T3 VTS YT T 81 83 83 &7 83 1 93 45 97 33 101 103 105 407 103 111 MF 115 1T 119 121 123125 127 129 131

01051243
Kl I ’i

W 13169 v 078

OF | Cancel | Apply | Help |

9. Import NGM_stutter_v1X:
a. Select the AmpFLSTR_NGM_v1X folder in the navigation panel.

* Panel Manager

File Edit Bins Wew Help

e 3% | B e E | [ |BinSet: INGM_bins_le v||
=- d%ﬁpana Manager Parel Hane Cotrarert.
C)AMPFLSTR_Panels_v1x | |1 NGM_panel_w1¥ null

o ArpFLS TR,

b. Select File » Import Marker Stutter to open the Import Marker Stutter
dialog box.

Q)
o)
>
o)
<
Q
o
o)
o
)
v
>
(7]
o)
=+
=
=
o

c. Navigate to, then open the NGM Analysis Files GMIDX folder.
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d.

Select NGM_stutter_v1X, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the NGM_bins_v1X folder.

x|
Lawak in: |E| MGM Analysis Files GMIDY LI il =

(CE_35_MGM_E5500., 2wl
MGM_Analysisiathod 13X, xml
[Z] MGEM_hins_w1z.bxt

[Z] MEM_panel_v1s,bxt

(B MEM_stukter w1,k

File name: INGM_stutter_le.txt Irnpart

Files of kype: I'D'" Files j Cancel |

10. View the imported marker stutters in the navigation pane:

a.

w* Panel Manager L1

Select the NGM_panel_v1X folder to display its list of markers in the
right pane.

Double-click the NGM_panel_v1X folder to display its list of markers
below it.

. Double-click D22S1045 to display the Stutter Ratio & Distance view for

the marker in the right pane.

Because D22S1045 has a trinucleotide repeat unit, it produces a higher
level of plus stutter than tetranucleotide markers, and so requires the use of
a plus stutter filter. The settings for the D22S1045 plus stutter filter can be
seen in the table in the right pane. Other markers may not require a plus
stutter filter, in which case the settings for plus stutter are left blank.

Ix

File Edit Ens Yew Help

X | E W

| B Ein et [t bins vt WML ERE AEEEEEE| o

[l ghy Panel Manager

D1051248

-

D AmpFLSTR Panels_vi |
[ AmpFLSTR_MGM_v 13

-

ease enter the stutter filter(s) for D225104% marker here If left blank, the global stutter filter will be applic

D EINGM_panel_vix Minus Stutter Plus Stutter
Ratio Fram Distance Ta Distance Ratio From Distance Ta Distance
1 L1550 2.25 3,75 1 .1oo0 2.25 3,75
4 4
3 3
4 4
Mew I Edit I Delete
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11. Click Apply, then OK to add the AmpF(STR® NGM™ Kit panels, bin sets, and
marker stutter to the GeneMapper® ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the
panels, bin sets, and marker stutter will not be imported into the GeneMapper®

ID-X Software database.

Import an  Use the following procedure to import the analysis method for the AmpF(STR®
analysis method NGM "™ Kit from the folder that you downloaded from the Applied Biosystems web
site into the GeneMapper® ID-X Software database. Refer to step 1 on page 54 for

downloading instructions.

1. Select Tools » GeneMapper® ID-X Manager to open the
GeneMapper /D-X Manager.

2. Import an analysis method:

a. Select the Analysis Methods tab, then click Import.

'\" GeneMapper® ID-X Manager e ﬂ

Find Mare Containing: I

Frojecks Analysis Methods | Tahle Settings' Plat Settings' Matrices' Size: Standards| Report Settings'
Marme Last Saved Cnainer Inskrument Analysis Type [Description

| BmpFLSTR Analysis Method 2007-12-18 16:18:% | gmid: HID H

Help | Done |

b. Navigate to, then open the NGM Analysis Files GMIDX folder.

3. Select NGM_AnalysisMethod_v1X, then click Import to import
NGM_AnalysisMethod_v1X into the GeneMapper® ID-X Software database.

gb Import Analysis Method ]

Look in: |i;~:, N Analysis Files GMIDY j G i, B =

(CE_G5_NEM_G5500. %l
Jm] MGM_Analysistethod _vi.xml

Q)
o)
>
o)
<
Q
o
o)
o
)
v
>
(7]
o)
=+
=
=
o

File name: INGM_AnaIysisMethad_le.xrnl Import |
Files of bype: IXML Files {* .l j Canicel |
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View Analysis To view the settings for NGM_AnalysisMethod_v1X, select the Analysis Methods
Method Editor tab, then select NGM_AnalysisMethod_v1X in the Name column and click Open.
tab settings

|i' GeneMapper® ID-X Manager s EI

Find Mame Containing: I

Projects Analysis Methods | Table Settings | Plat Settings | Matrices | Size Standards | Report Settings

Mame Last Saved Ciwner Instrument Analysis Type Description
AmpFLSTR Analysis Method 2009-06-30 15:48:2 | gridy: HID &
NGM_AnalysisMethod_v1x 2009-06-30 15:49:2 | gmid:: HID T

e, . | Qpen. .. | Save fs... | Impark. .. | Expart... | Delete |

Help | Done |

Figure 11 Analysis Method Editor: General tab settings

Figures 12 through 15 show the settings for each tab of the Analysis Method Editor.

Analysis Method Editor il x|
General  Allels I Peak Detectar I Pieak Quality | S0 & GO Settings |
Bin Set:
[v Use marker-specific skutter ratio and diskance if available
Marker Repeat Type: Tri Tetra Penta Hexa
lobal Cut-off Yalue jo.0 jo.0 jo.o fo.0
MMinus4 Ratio 0.0 0.0 0.0 0.0
Minusa Diskance Frorm 0.0 0.0 0.0 0.0
To |00 jo.0 jo.o fo.0
lobal Minus Stutter Ratio fo.0 0.0 jo.o fo.0
Global Minus Skutter Distance  From 2,25 3.25 0.0 0.0
To 53.75 4.75 0.0 0.0
lobal Plus Stutter Ratio fo.0 0.0 jo.o fo.0
Global Plus Stutker Diskance From 0.0 0.0 0.0 0.0
Ta 0.0 0.0 0.0 0.0
annelogenin Cukaff ID.EI
Range Filker. .. | Factaory Defaults
Save As | Save | Cancel I Help I

Figure 12 Analysis Method Editor: Allele tab settings
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+ GeneMapper® ID-X Software v1.0.1 or higher allows you to specify four types
of marker repeat motifs: tri, tetra, penta, and hexa. You can enter parameter
values for each type of repeat in the appropriate column.

» The “Use marker-specific stutter ratio if available” check box is selected by
default. Consequently, the software applies the stutter ratio filters supplied in

the NGM_stutter_v1X file.

Analysis Method Editor L x|

Generall Allele F'

Peak Detection Algorithm: advanced

~Peak Detection

Stop FER 10000

~Ranges

Analysis Sizing

Full Range ;I I.ﬁ.ll Sizes ;I
Shart PE0 Stark: Size:jd

Stop) Sizes {1000

- Smookhing and Baselining

" Mone
% Light
" Heawy

|51 pts

Smookhing

Baseline Window:

~Slope Threshold

~Size Calling Method
 2nd Crder Least Squares
+ 3rd Order Least Squares

" Cubic Spline Inkerpolakion

" Local Southern Method
" @Elobal Southern Method

Peak Amplitude Thresholds:

B: | TBD R | TBD

G: | TBD o: | TBD

v [TBD |

Mir. Peak Half width: 2 pts

Polynomial Degree:

Peak. Window Size: 5 pts

Peak Skart: 0

T

Peak End: 0

Eactory Defaults

Save As Save

Cancel Help

Figure 13 Analysis Method Editor: Peak Detector tab settings

IMPORTANT! Laboratories need to perform the appropriate internal validation
studies to determine the peak amplitude thresholds that allow for reliable
interpretation of AmpF(STR® NGM™ Kit data.

The software uses the peak amplitude threshold parameters to specify the minimum
peak height to limit the number of detected peaks. Although GeneMapper® ID-X
Software displays peaks that fall below the specified amplitude in
electropherograms, the software does not label or determine the genotype of these

peaks.
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Analysis Methoed Editor x|

General | Allele | Peak Detector Peak Quality I 50 & G0 Settings |

~Min/MMax Peak Height {LPH/TMPH)
Homozygous min peak height TBD

Heterozygous min peak height TBD

EEE

Mazx Peak Height (MPH =000.0

~Peak Height Ratio {PHR)

1Min peak height: ratio

.

~Broad Peak (B

ﬂ

Mazx peak width (basepairs)

~Allele Mumber (AR}

T

Max expected alleles

~hllzlic Ladder Spike

Cut-off Yalue

;

Save As | Save | Cancel | Help |

Figure 14 Analysis Method Editor: Peak Quality tab settings

IMPORTANT! Laboratories need to perform the appropriate internal validation
studies to determine the minimum heterozygous and homozygous minimum peak
height thresholds and the minimum peak height ratio threshold that allow for reliable
interpretation of AmpF(STR® NGM™ Kit data.
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Analysis Method Editor I x|

General I allele I Peak Detector | Peak Quality 5% & GO Settings I

Cuality weights are between 0 and 1.
5ample and Conkrol GO Weighting

Broad Peak (BL) IF Allele Mumber (AR IT
Out of Bin Allele (BIN) [os Low Peak Height {LPH) =
Orverlap (OYL) [os Max Peak Height (MPH) — [0.3
Marker Spike (SPK) = OFf-scale (0S) [os

Peak Height Ratio (PHR)  [0.3

Conkrol Concordance {CC) Weight = 1.0 {Only applicable o conkrols)

50 Weighting
Broad Peak (B 0.5

~Allelic Ladder G0 Weighting

Spike (S5PK/SPK) |1 ~| OFf-scale (OS]

S50 & G0 Ranges

il

Sizing CQuality: Frorm ID.T-"S to 1.0 From 0.0ko ID.25

Genotype Qualiey:  From  |0.75 ta 1.0 From 0.0 ka IIZI.25

Reset Defaults |

Save As | Save | Cancel | Help |

Figure 15 Analysis Method Editor: SQ and GQ tab settings

Import a HID size  The size standard for the AmpF(STR® NGM™ PCR Amplification Kit uses the
standard following GS500 peaks in its sizing algorithm: 75, 100, 139, 150, 160, 200, 300, 350,
400, and 450.

Use the following procedure to import the size standard for the AmpF(STR® NGM™
Kit from the folder that you downloaded from the Applied Biosystems web site, into
the GeneMapper® ID-X Software database. Refer to step 1 on page 54 for
downloading instructions.

Q)
o)
>
o)
<
Q
o
o)
o
)
v
>
(7]
o)
=+
=
=
o

1. Select Tools » GeneMapper® ID-X Manager to open the GeneMapper® ID-X
Manager.
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2. Import a size standard:

a. Select the Size Standards tab, then click Import.

.l' GeneMapper® ID-X Manager

Find Mame Containing: I

Projects | Analysis Methodsl Tahle Settingsl Plak Settings' Matrices  Size Standards | Repork SBttingsl

Mame Last Saved Cnaner Type Descripkion
CE_F_HID_a3500 {75-400) |2007-08-09 13:23:5 | gmid:x Advanced -
CE_F_HID_55500 (75-450) |2007-08-09 13:24:0| grid: Advanced
CE_55_HID_55500 2006-10-11 13:12:2 | grid: Advanced -
Mew, .. CIEE . Save B, Import... Expart,. . [e|ete |

Help | Done |

b. Navigate to, then open the NGM Analysis Files GMIDX folder.

3. Select CE_G5_NGM_GS500, then click Import to import the

CE_G5_NGM_GS500 analysis method into the GeneMapper® ID-X Software

database.

Lock in: IB NGM Analysis Files GMIDY j G =

g* Import Size Standard Method I ﬂ

MEM_AnalysisMethod_w 1k, xml

File name: |CE_GS_NGM_GSSEID.me Irnpaork |
Files of type: IXML Files (*, ) j Cance |
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Analyze and edit sample files with GeneMapper® ID-X

Software

Analyze a project 1. In the Project window, select File » Add Samples to Project, then navigate to
the disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings
Sample Type Select the sample type.
Analysis Method NGM_AnalysisMethod_v1X
Panel NGM_panel_v1X
Size Standard CE_G5_NGM_GS500

Size Standard: For more information about how the Size Caller works,
refer to the ABI PRISM® GeneScan® Analysis Software for the Windows
NT® Operating System Overview of the Analysis Parameters and Size
Caller User Bulletin (PN 4335617).

CE_G5_NGM_GS500 (size standard fragments defined in the
AmpF(STR® NGM™ Kit): 75, 100, 139, 150, 160, 200, 300, 350, 400, and
450. For additional information about size standards, refer to the
GeneMapper® ID Software Version 3.1 Human Identification Analysis
User Guide (PN 4338775), Appendix D.

CE_G5_NGM_GS500: Neither the 250-nt nor the 340-nt peak is included
in the size standard definition. These peaks can be used as an indicator of
precision within a run.

3. Click # (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage completed indicated.

The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

The Analysis Summary tab is displayed upon completion of the analysis.
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#! GeneMapper® ID-X - NGM analysis example - gmidx Is Logged In Database fosgreenrxi04 ' ) = |D|ﬂ
File Edit Analysis Wew Tools Admin Help
mEm N | | r e | = 1 | | ) |TabIeSetting: | ISIXXDataAnaIysis ﬂ | FoRr=2F.1 | 7
= g Project ] samples Analysis Summary | Ganotypes |
- [C2IMEM analysis example
Analysis Summary Surnmaty Generation Date: Jun 18, 2
Select run Folder to display: INGM analysis example j
Sample Status Total # of Samples
E Unanalyzed i}
Analyzed 16
L\lj Analysis Setting Changed o

Click a link below to display a filtered Samples Tahle containing only the samples selected.

Allelic Ladder Quality per run folder (hased on SQ and CGQO only)

Run Folder Total # of Analyzed Ladders ] & O

MEM analysis example 1 o o

Control Quality per project (based on sample POWs: S05, SSPK, MIX, OMR, 50, CGQ)

Control Type Total # of Samples ﬁ All thresholds met o One or more thresholds not met
Positive Contraol i ik o
Custorn Control ] ] ]
Megative Contraol 1 ik o
Tatal Z 2 o

Sample Quality per project (based on sample POWs: S05, SS5PK, MIX, OMR, 50, CGQ)

Taotal # of Samples [ Al thresholds met o one of more thresholds not met:

Samples 13 4 =)
4 | i

Analysis Completed,

| Stop

Examine and edit
a project

Figure 16 Analysis summary window after analysis

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).
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For more information

+ For quick set-up instructions, refer to the GeneMapper® ID-X Software Version
1.0 Getting Started Guide (PN 4375574).
+  For details about GeneMapper® ID-X Software features, allele filters, peak
detection algorithms, and project editing, refer to:
—  GeneMapper® ID-X Sofiware Version 1.0 Getting Started Guide
(PN 4375574)

—  GeneMapper® ID-X Sofiware Version 1.0 Quick Reference Guide
(PN 4375670)

—  GeneMapper® ID-X Sofiware Version 1.0 Reference Guide (PN 4375671)

—  GeneMapper® ID-X Sofiware Version 1.1 (Mixture Analysis Tool) Getting
Started Guide (PN 4396773)

—  GeneMapper® ID-X Sofiware Version 1.1 (Mixture Analysis Tool) Quick
Reference Guide (PN 4402094)
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Chapter 5 Experiments and Results

Overview

Experiments
using the
AmpF(STR®
NGM™ Kit

Importance of
validation

Experiment
conditions

This chapter provides results of the developmental validation experiments performed
by Applied Biosystems using the AmpF(STR® NGM™ PCR Amplification Kit.

Validation of a DNA typing procedure for human identification applications is an
evaluation of the procedure’s efficiency, reliability, and performance characteristics.
By challenging the procedure with samples commonly encountered in forensic and
parentage laboratories, the validation process uncovers attributes and limitations that
are critical for sound data interpretation in casework (Sparkes, Kimpton, Watson et
al., 1996; Sparkes, Kimpton, Gilbard et al., 1996; Wallin ef al., 1998).

Experiments to evaluate the performance of the AmpF(STR® NGM™ PCR
Amplification Kit were performed at Applied Biosystems. The experiments were
performed according to the revised guidelines from the Scientific Working Group on
DNA Analysis Methods (SWGDAM, July 10, 2003). Based on these guidelines,
Applied Biosystems conducted experiments that comply with guidelines 1.0 and 2.0
and its associated subsections. This DNA methodology is not novel. (Moretti ef al.,
2001; Frank et al., 2001; Wallin et al., 2002; and Holt et al., 2000).

This chapter discusses many of the experiments performed by Applied Biosystems
and provides examples of results obtained. Applied Biosystems chose conditions that
produced optimum PCR product yield and that met reproducible performance
standards. It is the opinion of Applied Biosystems that while these experiments are
not exhaustive, they are appropriate for a manufacturer of STR kits intended for
forensic and/or parentage testing use.

IMPORTANT! Each laboratory using the AmpF(STR® NGM™ PCR Amplification
Kit must perform internal validation studies.
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Developmental validation

SWGDAM
guideline 1.2.1

SWGDAM
guideline 2.10.1

PCR components

“Developmental validation is the demonstration of the accuracy, precision, and
reproducibility of a procedure by the manufacturer, technical organization, academic
institution, government laboratory, or other party.” (SWGDAM, July 2003)

“The reaction conditions needed to provide the required degree of specificity and
robustness must be determined. These include thermocycling parameters, the
concentration of primers, magnesium chloride, DNA polymerase, and other critical
reagents.” (SWGDAM, July 2003)

Applied Biosystems examined the concentration of each component of the
AmpF(STR® NGM™ Kit and established that the concentration of each component
was within the range where data indicated that the amplification met the required
performance criteria for specificity, sensitivity, and reproducibility. For example, 1ng
of Control DNA 007 was amplified in the presence of varying concentrations of
magnesium chloride, and the results were analyzed on an Applied Biosystems 3130x/
Genetic Analyzer. Results are shown in Figure 17. The performance of the multiplex
is most robust within +£20% of the optimal magnesium chloride concentration.

ERRY| Ui bl b g Ldogg *3%

[~ Mark Sample for Deletion

R T Ll Ll veo%

™ Mtk 5ampls for Deletion

ERN T TR

™ Mark Sample For Deletion

ERA DL dl L oo L g Cptima

™ Mark Sample For Deletion

ER| U L wlid T Y I ek

[~ Mark Sample For Deletion

ERTT Md tb ol oo oo L] 2%

[~ Mark Sample For Deletion

l -30%

ER T

Figure 17 1.0 ng of control DNA 007 amplified with the AmpF(STR® NGM™ Kit in
the presence of varying concentrations of magnesium chloride and analyzed on
an Applied Biosystems 3130x/ Genetic Analyzer.
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Thermal cycler
parameters

PCR cycle
number

Thermal cycling parameters were optimized using a Design of Experiments (DOE)
approach that attempts to identify the combination of temperatures and hold times
that produce the best assay performance. Optimal assay performance was determined
through evaluation of assay sensitivity, peak-height balance and resistance to PCR
inhibitors.

For example, annealing temperatures of 55, 57, 59, 61, and 63 °C were tested using a
Silver 96-Well GeneAmp® PCR System 9700 (Figure 18). The PCR products were
analyzed using an Applied Biosystems 3130x/ Genetic Analyzer.

Of the tested annealing temperatures, 55 to 61 °C produced robust profiles. At 63 °C
the yield of the majority of loci was significantly reduced. The optimal combination
of specificity, sensitivity, and resistance to PCR inhibition was observed at 59 °C.
Thermal cycler temperature is critical to assay performance; therefore, routine,
regularly scheduled thermal cycler calibration is strongly recommended.

55 °C

e Wt
b UL o

61 °C

63 °C
i N | “ [ 1

Figure 18 Electropherograms obtained from amplification of 1.0 ng of control
DNA 007 at annealing temperatures of 55 °C, 57 °C, 59 °C, 61 °C, and 63 °C,
analyzed on an Applied Biosystems 3130x/ Genetic Analyzer, (Y-axis scale

0 to 3,000 RFU).

AmpF(STR® NGM™ Kit reactions were amplified for 27, 28, 29, 30, and 31 cycles
on the Silver 96-Well GeneAmp® PCR System 9700 using 1.0 ng of each of three
DNA samples. As expected, the amount of PCR product increased with the number
of cycles. A full profile was generated for all numbers of thermal cycles (27-31) and
off-scale data were collected for several allele peaks at 30 and 31 cycles (Figure 19).

Optimal sensitivity was produced by 29 cycles when the amplified products were
analyzed on Applied Biosystems 3130x/ Genetic Analyzers. None of the cycle
numbers tested produced nonspecific peaks.
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N VU U | W ! 1 0 Y B

- 30 cycles
I | | W W

27 cycles
Ak bbb TN 4.4 Ty i b 't i i " "
™ Mark Sample for Deletion
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b il [TV TN 'Y U0 O S B 't
™ Matk Sample For Deletion
29 cycles

[ Mark Sariple for Deletion

I~ Mark 3ample for Deletion

m 31 cycles
S T T

Figure 19 Representative AmpF(STR® NGM™ Kit profiles obtained from
amplification of 1.0 ng DNA template using 27, 28, 29, 30, and 31 cycles,
analyzed on an Applied Biosystems 3130x/ Genetic Analyzer, (Y-axis scale 0 to
8,000 RFU)
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Accuracy, precision, and reproducibility

SWGDAM
guideline 2.9

Accuracy

“The extent to which a given set of measurements of the same sample agree with
their mean and the extent to which these measurements match the actual values being
measured should be determined.” (SWGDAM, July 2003)

Laser-induced fluorescence detection of length polymorphism at short tandem repeat
loci is not a novel methodology (Holt et al., 2000; and Wallin et al., 2002). However,
accuracy and reproducibility of AmpF{STR® NGM™ Kit profiles have been
determined from various sample types. Figure 20 shows the size differences that are
typically observed between sample alleles and allelic ladder alleles on the Applied
Biosystems 3130x/ Genetic Analyzer with POP-4™ polymer. The x-axis in Figure 20
represents the nominal nucleotide sizes for the AmpF(STR NGM™ Allelic Ladder.
The dashed lines parallel to the x-axis represent the £0.25-nt windows. The y-axis
represents the deviation of each sample allele size from the corresponding allelic
ladder allele size. All sample alleles are within 0.5 nt from a corresponding allele in
the allelic ladder.

0.50
-]
+
°
a
* DBS1179
L] D10S1248
= B D29
0 D16S538
1R R T R R i
- 0 D198433
a DHsn
o D2281045
o FoA
o THOM
* VWA
&  AMEL

Size Difference (nt)
g

-0.50 ST T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T

80 100 120 140 160 180 200 220 240 260 280 300 320 340 360
Allele Size (nt)

Figure 20 Allele Size vs. Allelic Ladder Sizing for 42 samples analyzed on an
Applied Biosystems 3130x/ Genetic Analyzer. Size and ladder sizing for the
AmpF(STR NGM™ Kit were calculated using the GeneScan™ 500 LIZ® Size
Standard.
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Precision and Sizing precision enables the determination of accurate and reliable genotypes. Sizing

size windows precision was measured on an Applied Biosystems 3130x/ Genetic Analyzer. The
recommended method for genotyping is to employ a £0.5-nt “window” around the
size obtained for each allele in the AmpF{STR NGM™ Allelic Ladder. A £0.5-nt
window allows for the detection and correct assignment of alleles. Any sample allele
that sizes outside the specified window could be:

* An “off-ladder” allele, that is, an allele of a size that is not represented in the
AmpF(STR NGM™ Allelic Ladder

or

* An allele that does correspond to an allelic ladder allele, but whose size is just
outside a window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree
of precision in sizing an allele multiple times. Precision is measured by calculating
the standard deviation in the size values obtained for an allele that is run in several
injections on a capillary instrument or in several lanes of one gel.

Table 6 on page 80 shows typical precision results obtained from five runs

(16 capillaries/run) of the AmpF(STR® NGM™ Allelic Ladder on an Applied
Biosystems 3130x/ Genetic Analyzer (36-cm capillary and POP-4™ polymer), using
the GeneScan" 500 LIZ® Size Standard. The results were obtained within a set of
injections on a single capillary array.

Sample alleles may occasionally size outside of the £0.5-nt window for a respective
allelic ladder allele because of measurement error. The frequency of such an
occurrence is lowest in detection systems having the smallest standard deviations in
sizing. Figure 20 on page 78 illustrates the tight clustering of allele sizes obtained on
the Applied Biosystems 3130x/ Genetic Analyzer, where the standard deviation in
sizing is typically less than 0.15 nt. The instance of a sample allele sizing outside the
+0.5-nt window because of measurement error is relatively rare when the standard
deviation in sizing is approximately 0.15 nt or less (Smith, 1995).

For sample alleles that do not size within a +0.5-nt window, the PCR product must be
rerun to distinguish between a true off-ladder allele versus measurement error of a
sample allele that corresponds with an allele in the allelic ladder. Repeat analysis,
when necessary, provides an added level of confidence in the final allele assignment.

GeneMapper® ID Software and GeneMapper® ID-X Software automatically flag
sample alleles that do not size within the prescribed window around an allelic ladder
allele by labelling the allele as OL (off-ladder).

Maximum sizing precision is obtained within the same set of capillary injections.
Cross-platform sizing differences occur due to a number of factors including type
and concentration of polymer, run temperature, and electrophoresis conditions.
Variations in sizing can also occur between runs on the same instrument and between
runs on different instruments of the same platform type because of these factors.
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Applied Biosystems strongly recommends that the allele sizes be compared to the
sizes obtained for known alleles in the AmpF(STR® NGM™ Allelic Ladder from the
same run and then be converted to genotypes (as described in “Before you start” on
pages 39 and 53). See Table 6 for the results of five runs of the AmpF(STR® NGM™
Allelic Ladder on an Applied Biosystems 3130x/ Genetic Analyzer. For more
information on precision and genotyping, see Lazaruk ef al., 1998 and Mansfield
etal., 1998.

In Table 6, the mean sizes for all the alleles in each run (16 capillaries) were
calculated. The mean range shown in the table represents the lowest- and highest-
mean size values obtained across all five runs. Similarly, the standard deviation for
the allele sizing was calculated for all the alleles in each run. The standard deviation
range shown in Table 6 represents the lowest and highest standard deviation values
obtained across all five runs.

Table 6 Precision results of five runs (16 capillaries/run) of the AmpF(STR®

NGM™ Allelic Ladder

Allele Mean Standard Dev.
Amelogenin
X 100.54 - 100.68 0.052 - 0.064
Y 106.21 - 106.34 0.045 - 0.061
D10S1248
8 76.64 - 76.67 0.031 - 0.045
9 80.85 - 80.9 0.029 - 0.04
10 85.03 - 85.09 0.024 - 0.045
11 89.19 - 89.25 0.032 - 0.043
12 93.31 - 93.37 0.027 - 0.046
13 97.4 - 97.48 0.035 - 0.049
14 101.41 - 101.48 0.029 - 0.053
15 105.32-105.4 0.03-0.05
16 109.24 - 109.31 0.035 - 0.046
17 113.18 - 113.24 0.032 - 0.048
18 11714 - 117.21 0.025 - 0.044
D12S391
14 229.97 - 230.12 0.042 - 0.056
15 233.9 - 234.05 0.035 - 0.057
16 237.87 - 238.01 0.036 - 0.063
17 241.75 - 241.91 0.046 - 0.051
18 245.68 - 245.83 0.042 - 0.056
19 249.59 - 249.73 0.038 - 0.062
19.3 252.59 - 252.75 0.034 - 0.054
20 253.54 - 253.68 0.034 - 0.058
21 257.45 - 257.58 0.04 - 0.052
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Allele (continued) Mean Standard Dev.
22 261.3 - 261.47 0.037 - 0.05
23 265.27 - 265.43 0.039 - 0.063
24 269.29 - 269.44 0.039 - 0.05
25 273.28 - 273.42 0.034 - 0.059
26 277.22 - 277.38 0.045 - 0.053
27 281.31 - 281.45 0.049 - 0.066

D16S539
5 228.68 - 228.78 0.04 - 0.05
8 240.7 - 240.83 0.04 - 0.052
9 244.72 - 244.83 0.05 - 0.055
10 248.73 - 248.84 0.048 - 0.059
11 252.73 - 252.87 0.046 - 0.063
12 256.78 - 256.89 0.04 - 0.055
13 260.8 - 260.93 0.046 - 0.061
14 264.82 - 264.95 0.037 - 0.056
15 268.86 - 268.99 0.04 - 0.054
D18S51
7 262.24 - 262.34 0.04 - 0.068
9 270.36 - 270.49 0.046 - 0.062
10 274.43 - 274.56 0.04 - 0.063
10.2 276.45 - 276.56 0.05 - 0.065
11 278.5 - 278.62 0.048 - 0.069
12 282.56 - 282.71 0.059 - 0.075
13 286.64 - 286.78 0.038 - 0.073
13.2 288.67 - 288.79 0.057 - 0.073
14 290.76 - 290.88 0.046 - 0.069
14.2 292.75-292.9 0.061 - 0.075
15 294.83 - 294.98 0.055 - 0.082
16 298.95 - 299.08 0.056 - 0.077
17 303.1 - 303.23 0.053 - 0.088
18 307.24 - 307.39 0.06 - 0.079
19 311.39 - 311.52 0.066 - 0.086
20 315.53 - 315.65 0.056 - 0.087
21 319.66 - 319.8 0.062 - 0.077
22 323.86 - 323.99 0.063 - 0.082
23 327.92 - 328.04 0.061 - 0.076
24 332.03 - 332.16 0.058 - 0.079
25 336.16 - 336.27 0.056 - 0.085
26 340.27 - 340.39 0.072 - 0.079
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Allele (continued) Mean Standard Dev.
27 344.39 - 344.5 0.057 - 0.077
D19S433
9 1271 -127.2 0.027 - 0.05
10 130.98 - 131.06 0.033 - 0.05
11 134.88 - 134.96 0.032 - 0.052
12 138.83 - 138.9 0.023 - 0.045
12.2 140.96 - 141.03 0.027 - 0.043
13 143.04 - 143.13 0.03 - 0.049
13.2 145.21 - 145.28 0.029 - 0.041
14 147.28 - 147.37 0.026 - 0.051
14.2 149.44 - 149.52 0.03 - 0.047
15 151.48 - 151.57 0.028 - 0.04
15.2 153.54 - 153.63 0.036 - 0.047
16 155.53 - 155.64 0.032 - 0.048
16.2 157.58 - 157.68 0.039 - 0.051
17 159.55 - 159.67 0.04 - 0.056
17.2 161.54 - 161.66 0.039 - 0.047
D1S1656
9 175.77 - 175.96 0.046 - 0.09
10 179.67 - 179.85 0.047 - 0.08
11 183.53 - 183.71 0.054 - 0.08
12 187.39 - 187.57 0.056 - 0.078
13 191.24-191.4 0.04 - 0.069
14 195.13 - 195.29 0.04 - 0.062
14.3 198.01 - 198.16 0.04 - 0.061
15 198.87 - 199.02 0.045 - 0.07
15.3 201.86 - 202.01 0.046 - 0.062
16 202.72 - 202.88 0.034 - 0.06
16.3 205.76 - 205.91 0.05 - 0.06
17 206.63 - 206.79 0.044 - 0.063
17.3 209.66 - 209.82 0.048 - 0.064
18.3 213.56 - 213.73 0.047 - 0.061
19.3 217.48 - 217.64 0.044 - 0.073
20.3 221.4 - 221.56 0.042 - 0.064
D21S11
24 185.02 - 185.14 0.042 - 0.069
24.2 187.02 - 187.12 0.042 - 0.066
25 188.98 - 189.08 0.045 - 0.066
26 192.92 - 193.01 0.037 - 0.056
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Allele (continued) Mean Standard Dev.
27 196.87 - 196.96 0.036 - 0.052
28 200.75 - 200.83 0.032 - 0.052

28.2 202.71 - 202.81 0.036 - 0.053
29 204.69 - 204.78 0.035 - 0.045
29.2 206.73 - 206.82 0.039 - 0.049
30 208.71 - 208.8 0.04 - 0.048
30.2 210.68 - 210.78 0.039 - 0.049
31 212.7 - 212.79 0.034 - 0.05
31.2 214.67 - 214.76 0.037 - 0.049
32 216.69 - 216.78 0.04 - 0.046
32.2 218.65 - 218.75 0.04 - 0.048
33 220.67 - 220.76 0.031 - 0.056
33.2 222.62 - 222.72 0.036 - 0.059
34 224.74 - 224.85 0.039 - 0.048
34.2 226.65 - 226.74 0.042 - 0.055
35 228.7 - 228.8 0.042 - 0.057
35.2 230.64 - 230.73 0.041 - 0.052
36 232.62 - 232.74 0.042 - 0.046
37 236.68 - 236.78 0.037 - 0.052
38 240.61 - 240.71 0.04 - 0.052
D22S1045
8 79.99 - 80.08 0.034 - 0.058
9 83.08 - 83.18 0.037 - 0.058
10 86.14 - 86.25 0.041 - 0.063
11 89.2 - 89.33 0.043 - 0.065
12 92.26 - 92.37 0.047 - 0.067
13 95.29 - 95.43 0.045 - 0.069
14 98.33 - 98.46 0.044 - 0.07
15 101.3 - 101.42 0.054 - 0.066
16 104.2 - 104.32 0.043 - 0.064
17 107.13 - 107.24 0.054 - 0.068
18 110.06 - 110.17 0.052 - 0.069
19 113.02 - 113.13 0.046 - 0.059
D2S1338
15 289.59 - 289.7 0.038 - 0.054
16 293.68 - 293.78 0.036 - 0.053
17 297.73 - 297.82 0.042 - 0.055
18 301.81 - 301.9 0.046 - 0.064
19 305.9 - 306 0.043 - 0.06
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Allele (continued) Mean Standard Dev.
20 310.03 - 310.11 0.047 - 0.057
21 314.12 - 314.22 0.042 - 0.062
22 318.22 - 318.31 0.034 - 0.06
23 322.3 - 322.39 0.044 - 0.062
24 326.38 - 326.46 0.044 - 0.058
25 330.46 - 330.55 0.038 - 0.06
26 334.54 - 334.61 0.047 - 0.056
27 338.63 - 338.71 0.046 - 0.057
28 342.95 - 343.05 0.037 - 0.061

D2S441
9 80.29 - 80.38 0.028 - 0.054
10 84.41-84.5 0.033 - 0.057
11 88.51 - 88.62 0.03 - 0.062
12 91.66 - 91.76 0.046 - 0.067
13 92.58 - 92.69 0.045 - 0.062
14 96.49 - 96.62 0.036 - 0.069
15 100.51 - 100.63 0.045 - 0.067
16 104.4 - 104.53 0.038 - 0.056

D3S1358
12 134.88 - 134.99 0.043 - 0.064
13 138.98 - 139.12 0.042 - 0.064
14 143.23 - 143.38 0.035 - 0.051
15 147.4 - 147.55 0.047 - 0.057
16 151.78 - 151.91 0.042 - 0.063
17 155.99 - 156.16 0.051 - 0.074
18 160.04 - 160.21 0.063 - 0.075
19 163.88 - 164.06 0.064 - 0.079

D8S1179
8 123.54 - 123.64 0.04 - 0.068
9 127.61 - 127.71 0.039 - 0.071
10 131.7 - 131.81 0.045 - 0.064
11 135.86 - 135.95 0.045 - 0.07
12 140.1 - 140.2 0.046 - 0.056
13 144.67 - 144.77 0.043 - 0.058
14 149.13 - 149.23 0.046 - 0.07
15 153.45 - 153.57 0.053 - 0.069
16 157.7 - 157.85 0.054 - 0.073
17 161.86 - 162 0.056 - 0.086
18 165.94 - 166.07 0.054 - 0.085
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Allele (continued) Mean Standard Dev.
19 169.99 - 170.15 0.054 - 0.096
FGA
17 233.22 - 233.34 0.032 - 0.044
18 237.01 - 237.13 0.036 - 0.047
19 240.8 - 240.93 0.04 - 0.053
20 244.61 - 244.74 0.04 - 0.049
21 248.43 - 248.55 0.038 - 0.045
22 252.24 - 252.35 0.034 - 0.057
23 256.09 - 256.19 0.028 - 0.047
24 259.9 - 260.01 0.041 - 0.051
25 263.74 - 263.86 0.035 - 0.049
26 267.59 - 267.7 0.035 - 0.055
26.2 269.46 - 269.57 0.029 - 0.045
27 271.5-271.62 0.037 - 0.054
28 275.35 - 275.47 0.036 - 0.046
29 279.2 - 279.31 0.03 - 0.051
30 282.97 - 283.07 0.036 - 0.053
30.2 285.24 - 285.36 0.035 - 0.053
31.2 289.12 - 289.23 0.028 - 0.065
32.2 292.98 - 293.09 0.042 - 0.054
33.2 296.88 - 296.97 0.044 - 0.051
42.2 332.47 - 332.54 0.03 - 0.062
43.2 336.37 - 336.45 0.031 - 0.055
44.2 340.44 - 340.51 0.034 - 0.055
45.2 344.38 - 344.45 0.033 - 0.055
46.2 348.02 - 348.09 0.036 - 0.044
47.2 351.82 - 351.85 0.036 - 0.05
48.2 355.71 - 355.78 0.031 - 0.052
50.2 363.15 - 363.2 0.032 - 0.045
51.2 366.92 - 366.96 0.034 - 0.052
THO1
4 181.53 - 181.67 0.044 - 0.065
5 185.44 - 185.58 0.039 - 0.063
6 189.32 - 189.46 0.037 - 0.066
7 193.2 - 193.33 0.028 - 0.058
8 197.05 - 197.17 0.032 - 0.053
9 200.93 - 201.03 0.036 - 0.047
9.3 203.93 - 204.03 0.037 - 0.052
10 204.85 - 204.95 0.031 - 0.051
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Allele (continued) Mean Standard Dev.
11 208.78 - 208.9 0.036 - 0.048
13.3 219.64 - 219.75 0.038 - 0.047
VWA
11 153.74 - 153.84 0.041 - 0.065
12 157.91 - 158.03 0.038 - 0.067
13 162.04 - 162.18 0.039 - 0.069
14 166.28 - 166.42 0.054 - 0.078
15 170.22 - 170.34 0.047 - 0.081
16 174.22 - 174.36 0.043 - 0.087
17 178.23 - 178.36 0.039 - 0.074
18 182.17 - 182.29 0.044 - 0.074
19 186.13 - 186.25 0.044 - 0.075
20 190.06 - 190.2 0.039 - 0.067
21 193.95 - 194.08 0.039 - 0.058
22 197.85 - 197.97 0.04 - 0.057
23 201.69 - 201.79 0.032 - 0.051
24 206.01 - 206.12 0.032 - 0.063

Extra peaks in the electropherogram

Causes of extra
peaks

Stutter products

Peaks other than the target alleles may be detected on the electropherogram. Causes
for the appearance of extra peaks include stutter products, incomplete

3" A nucleotide addition (at the n-1 position), dye artifacts, and mixed DNA samples
(see DAB Standard 8.1.2.2).

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller (or less frequently, one repeat larger) than the major
STR product (Butler, 2005; Mulero et al., 2006). Sequence analysis of stutter
products at tetranucleotide STR loci has revealed that the stutter product is missing a
single tetranucleotide core repeat unit relative to the main allele (Walsh et al., 1996).

The proportion of the stutter product relative to the main allele (percent stutter) is
measured by dividing the height of the stutter peak by the height of the main allele
peak. Peak heights were measured for amplified samples (n = 996) at the loci used in
the AmpF(STR® NGM™ Kit. All data were generated on the Applied Biosystems
3130x! Genetic Analyzer.

Some conclusions from these measurements and observations are:

+ For each AmpF(STR® NGM™ Kit locus, the percent stutter generally increases
with allele length, as shown in Figures 21 to 25 on pages 87 to 89.
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Percent Stutter

Smaller alleles display a lower level of stutter relative to the longer alleles
within each locus.

Each allele within a locus displays a percent stutter that is consistent.

Stutter filter sets in GeneMapper® ID and GeneMapper® ID-X Software,
calculated as the mean stutter for the locus plus three standard deviations
(n=996), are shown in Table 7 on page 90. Peaks in the stutter position that are
above the highest observed percent stutter are not filtered. Peaks in the stutter
position that have not been filtered and remain labeled can be further evaluated.
For evaluation of mixed samples, see Figure 36 on page 108.

The measurement of percent stutter for allele peaks that are off-scale may be
unusually high due to artificial truncation of the main allele peak.

B 9 10 111213 14 1516 17 18 19 20 1314 15 16 17 18 19 20 2122 23 24 25 26 27 4 567 89 1011121314158
01051248 0128391 0168539

Figure 21 Stutter percentages for D10S1248, D12S391 and D16S539 loci (Blue
and red colors indicate loci labeled with FAM and PET dyes, respectively).
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Figure 22 Stutter percentages for the D18S51, D19S433 and D1S1656 loci
(Green, black and red colors indicate loci labeled with VIC, NED and PET dyes,
respectively).
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Figure 23 Stutter percentages for the D21S11, D22S1045 and D2S1338 loci
(Green, black/gray, and blue colors indicate loci labeled with VIC, NED and FAM
dyes, respectively. Black and gray data points associated with the D22S1045
locus indicate minus- and plus-stutter, respectively).
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Figure 24 Stutter percentages for the FGA and THO1 loci (Black data points

indicate loci labeled with NED dye).

Percent Stutter

Figure 25 Stutter percentages for the D2S441, D3S1358, D8S1179, and VWA
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Addition of 3" A
nucleotide

Table 7 Marker-specific stutter filter percentages for AmpF(STR® NGM™ Kit loci

Locus* % Stutter

D10S1248 12.89
vWA 11.82
D16S539 10.57
D2S1338 13.55
D8S1179 10.82
D21S11 11.40
D18S51 13.89
D22S1045 17.99
D19S433 11.06
THO1 5.26
FGA 12.61
D2S441 9.47
D3S1358 13.77
D1S1656 14.16
D12S391 15.84

+ These percentages are used as stutter filters in GeneMapper® /D v3.2.1 NGM_panels_v1 and
GeneMapper® ID-X NGM_stutter_v1X.

Many DNA polymerases can catalyze the addition of a single nucleotide
(predominantly adenosine) to the 3" ends of double-stranded PCR products (Clark,
1988; Magnuson et al., 1996). This nontemplate addition results in a PCR product
that is one nucleotide longer than the actual target sequence. The PCR product with
the extra nucleotide is referred to as the “+A” form.

The efficiency of +A addition is related to the particular sequence of the DNA at the
3" end of the PCR product. The AmpF(STR® NGM™ Kit includes two main design
features that promote maximum +A addition:

* The primer sequences have been optimized to encourage +A addition.

» The new, highly robust PCR chemistry allows complete +A addition with a
short final incubation at 60 °C for 10 minutes.

This final extension step gives the DNA polymerase additional time to complete +A
addition to all double-stranded PCR products. See Figure 26 on page 91 for examples
of incomplete and normal +A addition. Final extension incubation for longer than the
recommended 10 minutes may result in double +A addition, in which two non-
template adenosine residues are added to the PCR product. Double +A addition can
cause a peak morphology problem with “shoulders” on the right side of main allele
peaks, and is therefore to be avoided.
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Figure 26 Omitting the final extension step results in shoulders on main allele
peaks due to incomplete A nucleotide addition. Data are from an ABI PRISM®
3130x/ Genetic Analyzer using the AmpF(STR® NGM™ Kit.

Due to improved PCR buffer chemistry, the lack of +A addition is generally less an
issue with the AmpF(STR® NGM™ Kit than with earlier generation kits. However,
“shouldering” of allele peaks may still be observed if the amount of input DNA is
greater than that recommended by the NGM™ kit protocol. Amplification of excess
input DNA may also result in offscale data.

Artifacts  Artifacts and anomalies are seen in all molecular biological systems. Artifacts are
typically reproducible while anomalies are non-reproducible, intermittent
occurrences that are not observed consistently in a system (for example, spikes and
baseline noise). Due to improvements in PCR primer manufacturing processes, the
incidence of artifacts has been greatly reduced in the AmpF(STR® NGM™ Kit. NGM
Kit electropherograms are essentially free of reproducible dye artifacts within the
Kit's read region of 68-407 nt. Figure 27 on page 93 shows the very low baseline
level fluorescence of a typical negative control PCR using the AmpF(STR® NGM™
Kit.
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Most STR loci produce minus-stutter peaks as a byproduct of PCR amplification. A
process of “slippage” has been proposed as a molecular mechanism for stutter, where
the Taq DNA polymerase enzyme “slips” on the template DNA during replication
and produces a minority PCR product that is shorter than the template strand, usually
by one repeat unit. The stutter process may also occur in the opposite direction to
produce amplicon DNA that is usually one repeat unit longer than the template
strand, termed plus-stutter. While plus-stutter is normally much less significant than
minus-stutter in STR loci with tetranucleotide repeats, the incidence of plus-stutter
may be more significant in trinucleotide repeat-containing loci. The D22S1045 locus
in the NGM assay kit is a trinucleotide repeat locus, and shows an elevated level of
plus-stutter. For example, Figure 29 on page 94 is an electropherogram of the
D22S1045 locus showing plus stutter. GeneMapper® ID and GeneMapper® ID-X
analysis parameter files supplied for use with the NGM kit contain a plus-stutter
filter to prevent these peaks from being called in normal profiles.

Figure 28 on page 93 shows an example of a non-standard (minus 2-nt) stutter that
may be observed in certain STR loci such as D1S1656 with more complex nucleotide
sequences that include regions of dinucleotide TG repeats. Genotyping may result in
the detection of these artifacts as off-ladder (OL) alleles.

It is important to consider possible noise and artifacts when interpreting data from
the AmpF(STR® NGM™ Kit on the Applied Biosystems 3130/3130x/, ABI PRISM®
3100/3100-Avant, and ABI PRISM® 310 Genetic Analyzers. Note that a high degree
of magnification is used in the sample electropherograms shown in Figures 27 to 29
on pages 93 to 94.
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Figure 27 Examples of fluorescence background in data produced on an
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185 187 144 191 142 1935 147 143 20 ] 205 207 203 1 212 215 217 213 21 pieic]

q

225

a0

200

o0

B0

00

Main allele peak

400

-2 bp stutter

300

200

Normal -4 bp stutter

00

183

Figure 28 Example of a — 2 nt reproducible artifact at the D1S1656 locus. Data
produced on an Applied Biosystems 3130x/ Genetic Analyzer.

AmpFSTR® NGM™ PCR Ampilification Kit User’s Guide

93



Chapter 5 Experiments and Results

B S -1

82

&4

86

28

a8 a4 98 8% 00 02 104 06 0E M0 M2 14 ME ME 200 122 124

480

400

360

320

280

240

200

160

120

Main allele peak

Minus stutter

Plus stutter

Figure 29 NGM™ Kit assay electropherogram showing plus stutter associated
with the D22S1045 STR locus. Data produced on an Applied Biosystems 3130x/

Genetic Analyzer.
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Characterization of loci

SWGDAM  “The basic characteristics of a genetic marker must be determined and documented.”
guideline 2.1  (SWGDAM, July 2003)

This section describes basic characteristics of the 15 loci and the sex-determining
marker, Amelogenin, which are amplified with the AmpF(STR® NGM™ Kit. Most of
these loci have been extensively characterized by other laboratories.

Nature of the The primers for the Amelogenin locus flank a 6-nucleotide deletion within intron 1

polymorphisms  of the X homolog. Amplification results in 104-nt and 110-nt products from the X
and Y chromosomes, respectively. (Sizes are the actual nucleotide size according to
sequencing results, including 3" A nucleotide addition, and size may not correspond
exactly to allele mobility observed on capillary electrophoresis platforms.) With the
sole exception of D22S1045, a trinucleotide STR, the remaining AmpF(STR®
NGM™ Kit loci are tetranucleotide short tandem repeat (STR) loci. The length
differences among alleles of a particular locus result from differences in the number
of repeat units.

All the alleles in the AmpFlSTR® NGM™ Allelic Ladder, including microvariants,
have been subjected to sequencing at Applied Biosystems. In addition, other groups
in the scientific community have sequenced alleles at some of these loci (Nakahori et
al., 1991; Puers et al., 1993; Moller et al., 1994; Barber et al., 1995; Moller and
Brinkmann, 1995; Barber ef al., 1996; Barber and Parkin, 1996; Brinkmann et al.,
1998; Momhinweg et al., 1998; Watson et al., 1998). Among the various sources of
sequence data on the AmpF(STR® NGM™ Kit loci, there is consensus on the repeat
patterns and structure of the STRs.

Inheritance The Centre d'Etude du Polymorphisme Humain (CEPH) has collected DNA from
families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets
have been extensively studied all over the world and are routinely used to
characterize the mode of inheritance of various DNA loci. Each family set contains
three generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying
inheritance patterns (Begovich ef al., 1992).

Mapping The AmpF(STR® NGM™ Kit loci have been mapped, and the chromosomal locations
have been published (Nakahori et al., 1991; Edwards et al., 1992; Kimpton et al.,
1992; Mills et al., 1992; Sharma and Litt, 1992; Li et al., 1993; Straub et al., 1993;
Barber and Parkin, 1996).

Genetic linkage Two sets of STR loci in the AmpF(STR® NGM™ Kit are located on the same
chromosomes. VWA and D12S391 are located approximately 6.3 million bp apart on
the p arm of chromosome 12, while D2S1338 and D2S441 are located approximately
150 million bp apart on opposite arms of chromosome 2. Linkage disequilibrium
analysis was conducted on the genotype results from 996 individuals of three ethnic
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groups (see “Population data” on page 110). STR locus genotype results from the
population study were analyzed using the Linkage Disequilibrium module of
GenePop software version 4.0.10 (Raymond and Rousset, 1995; Rousset, 2008). See

Table 8 for results.

The relatively high probability values indicate that there is no statistically significant
linkage disequilibrium found between the pairs of loci located on the same

chromosome.

Table 8 GenePop LD Result (p value for pairwise analysis of loci)

Locus Chrom::ome Ch'ﬁl:‘;fes;m: ,&An::i;i?:r;-n Caucasian  Hispanic
Posiont  GOOMASS"  (N_3sp (N=350)  (N=293)
VWA p13.31 5.9
D12S391 p13.2 12.2 0.86 0.29 0.27
D2S441 pl4 68
D2S1338 q35 218 0.11 0.32 0.19

T STRlocus mapping data was obtained from the NCBI Map Viewer
http://www.ncbi.nim.nih.gov/projects/mapview/map_search.cgi?taxid=9606 or the UCSC
Genome Browser (http://genome.ucsc.edu/). GenePop LD analysis probability results (p values)
greater than 0.05 were considered to indicate that linkage disequilibrium between the loci within the
population tested was not statistically significant.
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Species specificity

SWGDAM  “For techniques designed to type human DNA, the potential to detect DNA from
Guideline 2.2 forensically relevant nonhuman species should be evaluated.” (SWGDAM, July
2003)

The AmpF(STR® NGM™ Kit provides the required specificity for detecting human
alleles.

Nonhuman studies

Nonhuman DNA may be present in forensic casework samples. The following
species were tested (in the specified amounts) using standard PCR and capillary
electrophoresis conditions for the AmpF(STR® NGM™ Kit.

* Primates: gorilla, chimpanzee, and macaque (1.0 ng each)

* Non-primates: mouse, dog, sheep, pig, rabbit, cat, horse, hamster, rat, chicken,
and cow (5.0 ng each)

* Microorganisms: Candida albicans, Staphylococcus aureus, Escherichia coli,
Neisseria gonorrhoeae, Bacillus subtilis, and Lactobacillus rhamnosus
(equivalent to 10° copies)

Results were assessed for the presence of any amplified peaks that would indicate
cross reactivity of the NGM Kit with any of these non-human species.

Figure 30 on page 98 shows example electropherogram results from the species
specificity tests. The chimpanzee and gorilla DNA samples produced partial profiles
within the 70 to 283 nucleotide region (gorilla data not shown). Macaque DNA
produced a strong amelogenin-X peak and two small out-of-marker-range peaks in
PET (data not shown).
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Figure 30 Representative electropherograms from a species specificity study

including positive and non-template controls (NTC)

The microorganisms, cow, sheep, pig, dog, cat, chicken, hamster, mouse, rabbit, and
rat did not yield detectable products. Of the non-primates, only horse DNA produced
a 96-bp fragment near the amelogenin locus in the VIC® dye.
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Sensitivity

SWGDAM
guideline 2.3

Importance of
quantification

Effect of DNA
quantity on
results

“When appropriate, the range of DNA quantities able to produce reliable typing
results should be determined.” (SWGDAM, July 2003)

The recommended amount of input DNA for the AmpF(STR® NGM™ Kit is 1.0 ng,
based on quantification using either the Quantifiler® Human or Quantifiler® Duo
Quantification kit and individual laboratories should determine the optimum input
DNA amount according to the quantification method in use in the laboratory. If the
sample contains degraded or inhibited DNA, amplification of a higher concentration
of DNA may be beneficial. In Figure 31 on page 100, the control DNA 007 was
serially diluted from 2.0 ng to 0.062 ng. Full profiles (32 PCR products) were
consistently obtained at 0.125 ng, but occasional partial profiles missing 1 to 3
alleles were observed at 0.062 ng.

If too much DNA is added to the PCR reaction, the increased amount of PCR product
that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by
the instrument (“off-scale” data).
* Off-scale data. Off-scale data is a problem because:

— quantification (peak height and area) for off-scale peaks is not accurate.
For example, an allele peak that is off-scale can cause the corresponding
stutter peak to appear higher in relative intensity, thus increasing the
calculated percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy
results in poor spectral separation (“pull-up”).

* Incomplete +A nucleotide addition.
To address these issues, reamplify the sample using less DNA.

When the total number of allele copies added to the PCR is extremely low,
unbalanced amplification of the alleles may occur because of stochastic fluctuation.

Individual laboratories may find it useful to determine an appropriate minimum peak
height threshold based on their own results and instruments using low amounts of
input DNA.
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Figure 31 Electropherograms for amplifications using 2 ng, 1 ng, 0.50 ng,
0.25 ng, 0.125 ng, and 0.062 ng of control DNA 007. Electrophoresis was
performed on an Applied Biosystems 3130x/ Genetic Analyzer. Note that the y-
axis scale is magnified for the smaller input amounts of DNA.
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Stability

SWGDAM
guideline 2.4

Degraded DNA

“The ability to obtain results from DNA recovered from biological samples deposited
on various substrates and subjected to various environmental and chemical insults
has been extensively documented. In most instances, assessment of the effects of
these factors on new forensic DNA procedures is not required. However, if substrates
and/or environmental and/or chemical insults could potentially affect the analytical
process, then the process should be evaluated using known samples to determine the
effects of such factors.” (SWGDAM, July 2003)

As the average size of degraded DNA approaches the size of the target sequence, the
amount of PCR product generated is reduced because of the reduced number of
intact templates in the size range necessary for amplification.

Degraded DNA was prepared to examine the potential for differential amplification
of loci. High-molecular-weight Raji DNA was sonicated and incubated with
increasing doses of DNase I (0 to 6 Units) for 20 minutes (Bender et al., 2004). The
DNA was examined by agarose gel analysis to determine the average size of the
DNA fragments at each time point.

Amplification of 1 ng of degraded DNA using the AmpF{STR® NGM™ Kit was
performed. As the DNA became progressively degraded, the loci failed to amplify
robustly in order of decreasing size. Preferential amplification was not observed.
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Figure 32 Ampilification of Raji DNA samples sonicated and incubated with
increasing doses of DNase I. Panels 1, 2, 3, and 4 correspond to 0, 4, 5, and
6 units of DNase I. Note that the y-axis scale is magnified for more degraded
samples, which generate lower peak heights.

Heme compounds have been identified as PCR inhibitors in DNA samples extracted
from bloodstains (DeFranchis et al., 1988; Akane ef al., 1994). It is believed that the
inhibitor is co-extracted and co-purified with the DNA and subsequently interferes
with PCR by inhibiting polymerase activity.

To examine the effects of hematin on the performance of the AmpF(STR® NGM™
Kit, 1 ng of control DNA 007 was amplified in the presence of increasing
concentrations of hematin for 29 cycles of amplification (Figure 33 on

page 103).The concentrations of hematin used were 0 uM, 50 uM, 100 uM, 150 uM,
and 200 uM (see Table 9 on page 103).

102

AmpFSTR® NGM™ PCR Amplification Kit User’s Guide



Stability

CTRL-NGM

[~ Mark Sample For Deletion

1 150 130 El 270 Bl 350

4000

3000

2000

1000

NGM

uninhibited
l l l 1 l lcontrol

I Mark Sample For Deletion

m 150 130 230 270 210 250

3000

- h “

NGM Plus

.“U Ll i “H L, .1%&%

CTRL-SGM

I Mark Sample for Deletion

110 150 130 230 270 31 350

3000

2000

1000

Ll Lt

SGM Plus
1 uninhibited

1 Al l lCon’trol

I~ Mark Sample for Deletion

110 150 130 2m:0 Ed am £

3000

2000

1000

SGM Plus
200 uM
hematin

Effect of
inhibitors —
humic acid

Figure 33 Electropherograms for the AmpF/STR NGM and SGM Plus kits show
the improved performance of the NGM kit in the presence of hematin compared
with previous AmpF(STR kits. In order from top to bottom, the panels show
profiles for: NGM Kit uninhibited control, NGM Kit with 200 uM hematin, SGM
Plus Kit uninhibited control and SGM Plus Kit with 200 pM hematin.

Table 9 NGM kit performance in simulated hematin inhibition (n = 3)

Hematin Concentration (uM) Number of Alleles Detected*
0 32,32, 32
50 32, 32,32
100 32,32, 32
150 32, 32,32
200 32,32, 32

T Only those peaks >50 RFU were counted. A complete profile with control DNA 007 yields 32 peaks
using the AmpF(STR® NGM™ Kit.

Traces of humic acid may inhibit the PCR amplification of DNA evidence collected
from soil. Amplification of 1 ng of control DNA 007 in the presence of increasing
amounts of humic acid was performed using the AmpF{STR® NGM"™ Kit for 29
cycles of amplification (see Figure 34). The concentrations of humic acid tested were
0, 20, 40, 60, and 80 ng/uL (see Table 10 on page 104).
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Figure 34 Electropherograms for the AmpF/STR NGM and SGM Plus kits show
improved performance of the NGM kit in the presence of humic acid compared to
previous AmpF(STR kits. In order from top to bottom, the panels show profiles
for: NGM Kit uninhibited control, NGM Kit with 80 ng/pL humic acid, SGM Plus Kit
uninhibited control and SGM Plus Kit with 80 ng/uL humic acid.

Table 10 NGM kit performance in simulated model of humic acid inhibition
(n=3)

Humic Acid Concentration (ng/uL) Number of Alleles Detected*

0 32, 32, 32
20 32, 32, 32
40 32, 32, 32
60 32, 32, 32
80 32, 32, 32

1 Only those peaks >50 RFU were counted. A complete profile with control DNA 007 yields 32 peaks
using the AmpF(STR® NGM™ Kit.
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Mixture studies

SWGDAM  “The ability to obtain reliable results from mixed source samples should be
guideline 2.8 determined.” (SWGDAM, July 2003)

Evidence samples may contain DNA from more than one individual. The possibility
of multiple contributors should be considered when interpreting the results. Applied
Biosystems recommends that individual laboratories determine a minimum peak
height threshold based on validation experiments performed in each laboratory to
avoid typing when stochastic effects are likely to interfere with accurate
interpretation of mixtures.

Mixture Studies Evidence samples that contain body fluids and/or tissues originating from more than
one individual are an integral component of forensic casework. Therefore, it is
essential to ensure that the DNA typing system is able to detect DNA mixtures.
Mixed samples can be distinguished from single-source samples by:

» The presence of more than two alleles at a locus

» The presence of a peak at a stutter position that is significantly greater in
percentage than typically observed in a single-source sample

+ Significantly imbalanced alleles for a heterozygous genotype

The peak height ratio is defined as the height of the lower peak (in RFU) divided by
the height of the higher peak (in RFU), expressed as a percentage. Mean, median,
minimum, and maximum peak height ratios observed for alleles in the AmpF¢(STR®
NGM™ Kit loci in unmixed population database samples are shown in Figure 35 on
page 106.
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Figure 35 Heterozygote ratios for 1 ng of input DNA. The distribution of intra-
locus peak height ratios are expressed as plus and minus percent, by locus.
Green boxes show the middle 50% or interquartile range (IQR). Box halves below
and above median show the second and third quartile, respectively. “Whiskers”
indicate 1.5 IQR from the upper and lower margins of the IQR. Red diamonds are
outlier data points more than 1.5 IQR from the median.

If an unusually low peak height ratio is observed for one locus, and there are no other
indications that the sample is a mixture, the sample may be reamplified and
reanalyzed to determine if the imbalance is reproducible. Possible causes of
imbalance at a locus are:

Degraded DNA

Presence of inhibitors

Extremely low amounts of input DNA

A mutation in one of the primer binding sites

Presence of an allele containing a rare sequence that does not amplify as
efficiently as the other allele

Resolution of genotypes in mixed samples

A sample containing DNA from two sources can comprise (at a single locus) any of
the seven genotype combinations (see below).

Heterozygote + heterozygote, no overlapping alleles
(four peaks)
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* Heterozygote + heterozygote, one overlapping allele
(three peaks)

* Heterozygote + heterozygote, two overlapping alleles
(two peaks)

* Heterozygote + homozygote, no overlapping alleles
(three peaks)

* Heterozygote + homozygote, overlapping allele
(two peaks)

* Homozygote + homozygote, no overlapping alleles
(two peaks)

* Homozygote + homozygote, overlapping allele
(one peak)

Specific genotype combinations and input DNA ratios of the samples contained in a
mixture determine whether or not it is possible to resolve the genotypes of the major
and minor component(s) at a single locus.

The ability to obtain and compare quantitative values for the different allele peak
heights on Applied Biosystems instruments provides additional valuable data to aid
in resolving mixed genotypes.

Ultimately, the likelihood that any sample is a mixture must be determined by the
analyst in the context of each particular case, including the information provided
from known reference sample(s).

Limit of detection of the minor component

Mixtures of two DNA samples were examined at various ratios (0:1, 1:1, 3:1, 7:1,
15:1, 1:0). The total amount of genomic input DNA mixed at each ratio was 1 ng.
The samples were amplified in a GeneAmp® PCR System 9700, then
electrophoresed and detected using an Applied Biosystems 3130x/ Genetic Analyzer.

The results of the mixed DNA samples are shown in Figure 36 on page 108 where
samples A and B were mixed according to the ratios indicated. The minor component
allele calls at non-overlapping loci are highlighted. Detection of full profiles for the
minor contributor was possible at ratios of 3:1 (0.750:0.250 ng) and 7:1
(0.875:0.125 ng). Generally, 15:1 ratios resulted in partial profiles for the minor
component. The profiles of these samples are described in Table 11 on page 109.
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Figure 36 Amplification of DNA mixtures at various ratios. Panels show
electropherograms for (top to bottom): Major contributor only, 1:1 mixture
(maj:min), 3:1 mixture, 7:1 mixture, 10:1 mixture and 15:1 mixture.
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Table 11  Genotypes of mixed DNA samples

Locus Sample A Genotype Sample B Genotype
D10S1248 13, 14 12,15
VWA 14,17 17,19
D16S539 10, 11 9,12
D2S1338 17,23 17,20
AMEL X, Y X
DS1179 11,14 10,11
D21S11 29, 35 31.2,32.2
D18S51 15,16 13,14
D22S10 45,15 15,16
D19S433 11,17.2 13
THO1 7,8 6, 9.3
FGA 19, 25 22,23
D2S441 11,12 11,14
D3S1358 14,17 15,16
D1S1656 12,18.3 11,15
D12S391 18,18.3 18,22
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Population data

SWGDAM
guideline 2.7

Overview

“The distribution of genetic markers in populations should be determined in relevant
population groups.” (SWGDAM, July 2003)

The AmpF(STR® NGM™ PCR Amplification Kit contains loci for which extensive
population data are available. For additional information on 11 loci shared between
the kits, see the population data and additional studies section of the AmpF&STR SGM
Plus® PCR Amplification Kit User’s Manual (PN 44309589).

Population samples used in these studies

The AmpF(STR® NGM™ PCR Amplification Kit was used to generate the
population data provided in this section. Whole blood samples, provided by the
Insterstate Blood Bank (Memphis, Tennessee), were collected in the United States
(with no geographical preference) from randomly selected individuals of known
ethnicities. Ethnicities of sample donors were:

* African-American — 350 samples

* Caucasian — 350 samples

* Hispanic — 296 samples
DNA was extracted using an ABI PRISM® 6100 Nucleic Acid PrepStation.

In addition to the alleles that were observed and recorded in the Applied Biosystems
databases, other alleles have been published or reported to Applied Biosystems by
other laboratories (see the STRBase at www.cstl.nist.gov/div831/strbase).
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Mutation rate

Estimating germ-  Estimation of spontaneous or induced germ-line mutation at genetic loci can be
line mutations achieved by comparing the genotypes of offspring to those of their parents. From
such comparisons the number of observed mutations are counted directly.

In previous studies, genotypes of ten STR loci that were amplified by the AmpF{STR
SGM Plus® PCR Amplification Kit were determined for a total of 146 parent-
offspring allelic transfers (meioses) at the Forensic Science Service, Birmingham,
England. One length-based STR mutation was observed at the D18S11 locus;
mutations were not detected at any of the other nine STR loci. The D18S11 mutation
was represented by an increase of one 4-nt repeat unit, allele 17 was inherited as
allele 18 (single-step mutation). The maternal/paternal source of this mutation could
not be distinguished.

Additional Additional studies (Edwards et al., 1991; Edwards et al., 1992; Weber and Wong,
mutation studies 1993; Hammond et al., 1994; Brinkmann et al., 1995; Chakraborty et al., 1996;
Chakraborty et al., 1997; Brinkmann et al., 1998; Momhinweg et al., 1998; Szibor et
al., 1998) of direct mutation rate counts produced:

+ Larger sample sizes for some of the AmpF(STR® NGM™ Kit loci.

* Methods for modifications of these mutation rates (to infer mutation rates
indirectly for those loci where the rates are not large enough to be measured
directly and/or to account for those events undetectable as Mendelian errors).
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Probability of identity

Table 12 shows the Probability of Identity (PI) values of the AmpF(STR® NGM™ Kit
loci individually and combined.

Table 12 Probability of identity values for the AmpF(STR® NGM™ Kit STR loci

Locus :;:;ﬁ:;'n Caucasian Hispanic
(N=350) (N=350) (N=293)
D10S1248 0.070 0.095 0.105
VWA 0.062 0.066 0.087
D16S539 0.072 0.104 0.080
D2S1338 0.023 0.032 0.031
D8S1179 0.075 0.064 0.067
D21S11 0.045 0.053 0.051
D18S51 0.031 0.031 0.028
D22S1045 0.054 0.132 0.149
D19S433 0.040 0.085 0.052
THO1 0.095 0.080 0.083
FGA 0.033 0.039 0.030
D2S441 0.101 0.097 0.099
D3S1358 0.100 0.075 0.087
D1S1656 0.034 0.022 0.025
D12S391 0.039 0.023 0.029
D10S1248 0.070 0.095 0.105
Combined 6.52 x 1020 2.78 x 1071° 2.59 x 10°1°

The P; value is the probability that two individuals selected at random will have an
identical AmpF(STR® NGM™ Kit genotype (Sensabaugh, 1982). The P, values for
the populations described in this section are then approximately 1/1.53 X 10"
(African-American), 1/3.60 X 10'® (U.S. Caucasian), and 1/3.86 X 10'3 (U.S.
Hispanic).
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Probability of paternity exclusion

Table 13 shows the Probability of Paternity Exclusion (Py) values of the AmpF{STR®
NGM™ Kit STR loci individually and combined.

Table 13 Probability of Paternity Exclusion values for the AmpF/STR® NGM™
PCR Amplification Kit® STR loci

African- Caucasian Hispanic
Locus American
(N=350) (N=350) (N=293)
D10S1248 0.659 0.572 0.488
VWA 0.599 0.652 0.622
D16S539 0.557 0.582 0.523
D251338 0.795 0.748 0.749
D8S1179 0.588 0.614 0.553
D21S11 0.726 0.731 0.681
D18S51 0.784 0.754 0.777
D22S1045 0.670 0.454 0.417
D19S433 0.637 0.506 0.641
THO1 0.512 0.506 0.565
FGA 0.726 0.663 0.681
D25441 0.522 0.492 0.494
D3S1358 0.483 0.531 0.477
D1S1656 0.743 0.807 0.708
D12S391 0.738 0.812 0.668
Combined 0.9999999193 0.9999998447 0.9999994515

The Py, value is the probability, averaged over all possible mother-child pairs, that a
random alleged father will be excluded from paternity after DNA typing of the
AmpF(STR® NGM™ Kit STR loci (Chakraborty, Stivers, and Zhong, 1996).
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Troubleshooting

Follow the actions recommended in this appendix to troubleshoot problems that
occur during analysis.

Observation

Possible causes

Recommended actions

Faint or no signal from
both the 007 and the
DNA test samples at all
loci

Incorrect volume or absence of either
AmpF(STR® NGM™ Master Mix or
AmpF(STR® NGM™ Primer Set

Repeat amplification using correct reagent
volumes.

No activation of enzyme

Repeat amplification, making sure to hold reactions
initially at 95 °C for 11 min.

Master Mix not vortexed thoroughly
before aliquoting

Vortex Master Mix thoroughly.

AmpF(STR NGM™ Primer Set
exposed to too much light

Store Primer Set protected from light.

GeneAmp® PCR System malfunction

Refer to the thermal cycler user’'s manual and
check instrument calibration.

Incorrect thermal cycler parameters

Check the protocol for correct thermal cycler
parameters.

Tubes/plate not seated tightly in the
thermal cycler during amplification

Push reaction tubes/plate firmly into contact with
block after first cycle. Repeat test.

Wrong PCR reaction tubes or plate

Use Applied Biosystems MicroAmp Reaction.
Tubes with Caps or the MicroAmp Optical 96-Well
Reaction Plate for the GeneAmp® PCR System
9700.

MicroAmp™ Base used with
tray/retainer set and tubes in
GeneAmp® PCR System 9700

Remove MicroAmp Base from tray/retainer set and
repeat test.

Insufficient PCR product
electrokinetically injected

For ABI Prism® 3100-Avant or Applied
Biosystems 3100/3130x/ runs: Mix 1.0 uL of
PCR product and 9 pL of Hi-Di™ Formamide/
GeneScan™ 500 LIZ® solution.

For ABI PRismM® 310 instrument runs: Mix
0.75 pL of PCR product and 24.24 uL of Hi-Di™
Formamide/GeneScan™ 500 LIZ® solution.

Degraded formamide

Check the storage of formamide; do not thaw and
refreeze multiple times. Try Hi-Di™ Formamide.
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Observation

Possible causes

Recommended actions

Positive signal from
AmpF(STR Control DNA
007 but partial or no
signal from DNA test
samples

Quantity of test DNA sample is below
assay sensitivity

Quantify DNA and add 1.0 ng of DNA. Repeat test.

Test sample contains high
concentration of PCR inhibitor (for
example, heme compounds, certain
dyes

Quantify DNA and add minimum necessary vol-
ume. Repeat test.

Wash the sample in a Centricon®-100 centrifugal
filter unit. Repeat test.

Test sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA or use
the AmpF(STR® MiniFiler™ Kit.

Dilution of test sample DNA in water or
wrong buffer (for example, TE formula
with incorrect EDTA concentration)

Redilute DNA using low TE Buffer
(with 0.1 mM EDTA).

More than two alleles
present at a locus

Presence of exogenous DNA

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Amplification of stutter product

Mixed sample

Interpret according to laboratory procedures.

Note: Additional information will be provided on
completion of validation.

Incomplete 3" A base addition
(n-1 nt position)

Addition of excess DNA to the reaction will
contribute to the occurrence of incomplete 3"
base addition. Quantify DNA and add 1.0 ng of
DNA to the reaction. Repeat test. Also be sure to
include the final extension step of 60 °C for

10 min in the PCR.

Signal exceeds dynamic range of
instrument (off-scale data)

Ensure cycle number is optimized according to
instructions on page 20. Repeat PCR
amplification using fewer PCR cycles or use your
laboratory’s SOP to analyze off-scale data.

Poor spectral separation (bad matrix)

Follow the steps for creating a spectral file.

Confirm that Filter Set G5 modules are installed
and used for analysis.

Too much DNA in reaction

Use recommended amount of template DNA
(1.0 ng).

Incomplete denaturation of double
stranded DNA

Use the recommended amount of Hi-Di™
Formamide and perform heat denaturation
according to instructions on page 30.

Poor peak height Incorrect thermal cycler parameters Check the protocol for correct thermal cycler
balance parameters.
GeneAmp® PCR System 9700 with Use Applied Biosystems GeneAmp® PCR System
Aluminum 96-Well block or third- 9700 with silver or gold-plated silver blocks only.
party thermal cyclers
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Safety

This appendix covers:

B Chemicalsafety.......... ...t 120
B Chemical waste safety........... ... i, 122
B Biological hazardsafety ........... .. .. ... . .. i 124
B Chemical alerts .. ......... .ttt 125

AmpFSTR® NGM™ PCR Amplification Kit User’s Guide 119



Appendix B Safety

Chemical safety

Chemical hazard WARNING! CHEMICAL HAZARD. Before handling any chemicals, refer
warning to the Material Safety Data Sheet (MSDS) provided by the manufacturer, and
observe all relevant precautions.

A WARNING! CHEMICAL HAZARD. All chemicals in the instrument,
including liquid in the lines, are potentially hazardous. Always determine what
chemicals have been used in the instrument before changing reagents or
instrument components. Wear appropriate eyewear, protective clothing, and
gloves when working on the instrument.

A WARNING! CHEMICAL STORAGE HAZARD. Never collect or store
waste in a glass container because of the risk of breaking or shattering.
Reagent and waste bottles can crack and leak. Each waste bottle should be
secured in a low-density polyethylene safety container with the cover fastened
and the handles locked in the upright position. Wear appropriate eyewear,
clothing, and gloves when handling reagent and waste bottles.

Chemical safety To minimize the hazards of chemicals:

guidelines * Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page 120.)

* Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood). For additional
safety guidelines, consult the MSDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the MSDS.

*  Comply with all local, state/provincial, or national laws and regulations related
to chemical storage, handling, and disposal.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with
the first shipment of a hazardous chemical to a customer after an MSDS has been
updated. MSDSs provide the safety information you need to store, handle, transport,
and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to
replace the appropriate MSDS in your files.
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Chemical safety

Obtaining The MSDS for any chemical supplied by Applied Biosystems is available to you free
MSDSs 24 hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then select MSDS.

2. In the Keyword Search field, enter the chemical name, product name, MSDS
part number, or other information that appears in the MSDS of interest. Select
the language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of
the following:

*  Open — To view the document
e Print Target — To print the document

» Save Target As — To download a PDF version of the document to a
destination that you choose

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact
the chemical manufacturer.
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Chemical waste safety

Chemical waste
hazards

WARNING! HAZARDOUS WASTE. Refer to Material Safety Data Sheets
and local regulations for handling and disposal.

WARNING! CHEMICAL WASTE HAZARD. Wastes produced by Applied
Biosystems instruments are potentially hazardous and can cause injury, illness,
or death.

WARNING! CHEMICAL STORAGE HAZARD. Never collect or store
waste in a glass container because of the risk of breaking or shattering.
Reagent and waste bottles can crack and leak. Each waste bottle should be
secured in a low-density polyethylene safety container with the cover fastened
and the handles locked in the upright position. Wear appropriate eyewear,
clothing, and gloves when handling reagent and waste bottles.

Chemical waste To minimize the hazards of chemical waste:

safety guidelines

L]

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle,
or dispose of chemical waste.

Provide primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks from
the primary container. Both containers must be compatible with the waste
material and meet federal, state, and local requirements for container storage.)
Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood). For additional
safety guidelines, consult the MSDS.

Handle chemical wastes in a fume hood.
After emptying a waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with
good laboratory practices and local, state/provincial, or national environmental
and health regulations.

Waste disposal If potentially hazardous waste is generated when you operate the instrument, you
must:

L]

Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure the health and safety of all personnel in your laboratory.
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Chemical waste safety

* Ensure that the instrument waste is stored, transferred, transported, and disposed
of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.
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Biological hazard safety

General WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,

biohazard infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial,
and/or national regulations. Wear appropriate protective equipment, which
includes but is not limited to: protective eyewear, face shield, clothing/lab coat,
and gloves. All work should be conducted in properly equipped facilities using
the appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and
company/institution requirements before working with potentially infectious
materials. Read and follow the applicable guidelines and/or regulatory
requirements in the following:

* U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories (stock no.
017-040-00547-4; bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030; www.access.gpo.gov/
nara/cfr/waisidx_01/29¢fr1910a_01.html)

* Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:

www.cdc.gov
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Chemical alerts

Chemical alerts

For the definitions of the alert words IMPORTANT, CAUTION, WARNING, and
DANGER, see “Safety alert words” on page vii.

General alerts for

all chemicals

Specific
chemical alerts

Avoid contact with skin, eyes, and/or clothing. Read the MSDS and follow the
handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

CAUTION! CHEMICAL HAZARD. AmpF{STR® NGM™ PCR
Amplification Kit may cause eye, skin, and respiratory tract irritation.
Sodium azide may react with lead and copper plumbing to form highly
explosive metal azides.

WARNING! CHEMICAL HAZARD. POP-4"™ Polymer for 3130/3130x/
Genetic Analyzers causes skin, eye, and respiratory tract irritation.

WARNING! CHEMICAL HAZARD. Running Buffer, 10 causes skin, eye,
and respiratory tract irritation.

WARNING! CHEMICAL HAZARD. Hi-Di"" Formamide is harmful if
swallowed, inhaled or absorbed through skin, and causes irritation to
skin, eyes, and respiratory tract. It affects the central nervous system and
may affect the reproductive system.

WARNING! CHEMICAL HAZARD. POP-4" Polymer for 3100/3100-
Avant Genetic Analyzers is irritating to eyes, respiratory system, and skin.
It causes adverse cardiovascular effects. It contains a known or suspected
reproductive toxin and a known or suspected mutagen.

WARNING! CHEMICAL HAZARD. POP-7" Polymer for the 3730
Genetic Analyzer is harmful by inhalation and if swallowed and irritating
to eyes, respiratory system, and skin.
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Documentation

Related documentation

For additional documentation, see “How to obtain support” on page 128.

Document title nu?li;te r
ABI Prism® 3100/3100-Avant Data Collection v2.0 User Guide 4347102
ABI PrisM® 3100/3100-Avant Genetic Analyzers Using Data Collection 4350218
Software v2.0 User Bulletin
ABI PrisM® 3100 Genetic Analyzer User Manual (Data Collection v1.1) 4315834

ABI PrisM® 3100/3100-Avant Genetic Analyzers Protocols for Processing 4332345
AmpF(STR® PCR Amplification Kit PCR Products User Bulletin

AmpFISTR® PCR Amplification Kit - PCR Setup Quick Reference Card 4442401

AmpFISTR® PCR Amplification Kit - CE Quick Reference Card 4442693

Applied Biosystems 3130/3100x! Genetic Analyzers Using Data Collection 4363787
Software v3.0 User Bulletin

Applied Biosystems 3130/3130xI Genetic Analyzers Getting Started Guide 4352715

Applied Biosystems 3130/3130xI Genetic Analyzers Maintenance, 4352716
Troubleshooting, and Reference Guide

Applied Biosystems 3130/3130xI Genetic Analyzers Quick Reference Card 4362825

Applied Biosystems 3130/3130x/ Genetic Analyzers AB Navigator Software 4359472
Administrator Guide

Applied Biosystems 3130/3100xI DNA Analyzers User Guide 4331468

Applied Biosystems 3730/3730xI Genetic Analyzer Getting Started Guide 4359476

Quantifiler® Kits: Quantifiler® Human DNA Quantification Kit and Quantifiler® | 4344790
Y Human Male DNA Quantification Kit User’s Manual

PrepFiler™ Forensic DNA Extraction Kit User Guide 4390932
GeneMapper® ID Software Version 3.1 Human Identification Analysis User 4338775
Guide

GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification 4335523

Analysis Tutorial

Installation Procedures and New Features for GeneMapper® ID Software v3.2 | 4352543
User Bulletin
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Documentation

GeneMapper® ID-X Software Version 1.0 Getting Started Guide 4375574
GeneMapper® ID-X Software Version 1.0 Quick Reference Guide 4375670
GeneMapper® ID-X Software Version 1.0 Reference Guide 4375671

GeneMapper® ID-X Software Version 1.1 (Mixture Analysis) Getting Started 4396773
Guide

GeneMapper® ID-X Software Version 1.1 (Mixture Analysis) Quick Reference | 4402094
Guide

Portable document format (PDF) versions of this guide and the documents listed
above are available at www.appliedbiosystems.com

Note: To open the user documentation available from the Applied Biosystems web
site, use the Adobe® Acrobat® Reader® software available from www.adobe.com

How to obtain support

For the latest services and support information for all locations, go to:
www.appliedbiosystems.com

At the Applied Biosystems web site, you can:
* Access worldwide telephone and fax numbers to contact Applied Biosystems
Technical Support and Sales facilities.
* Search through frequently asked questions (FAQs).
* Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, MSDSs, certificates of analysis,
and other related documents.

* Download PDF documents.
* Obtain information about customer training.
» Download software updates and patches.
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